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To say that the last few weeks have been hectic
would be the understatement of the relatively new
millennium. So much has gone on and happened, it
has been a whirlwind of activity that has left my head
spinning still.

On the last weekend of July, we had my son’s
birthday party. Even though his birthday is August 6,
we moved his party up a week because of the fear
that Laura (my wife) would be delivering our second
child. We wanted, if at all possible, to avoid spoiling
his third birthday party with mom and dad having to
be at the hospital, instead of being at his birthday
party.

Except, we didn’t calculate it quite right. The day that
we chose for his birthday party was the exact time
(gestationally) in this most recent pregnancy as
when he was born: 36 weeks, 2 days (normal
gestation is 40 weeks). Statistically speaking, if your
first child comes early, then there’s a great chance
your second one will too.

So, we just held our collective breaths, and hoped
for the best. Indeed, it looked at the end of his party
as if we might be in for an extra dose of drama. As
the party was winding down and we were starting to
pack things up at the shelter house at the local park,
my wife started having strong contractions.
Fortunately, they subsided and the rest of the
evening was calm and uneventful.

A week later, we celebrated his actual third birthday,
with just him with mom and dad. He got a cool little
Lil’ Tikes 4x4 pickup truck that is foot powered and
that you ride in. Just put your feet on the floor and
push. He was so excited about his new toy truck, I’m
a bit surprised he didn’t try to sleep in it.

By this time, we’re doing weekly doctor
appointments with the OB/Gyn, along with weekly
sonograms of baby’s development. Mom was
already dilated to 5 cm, which is half way (10 cm is
considered “complete”). Just as with our first
pregnancy, mom had a problem with PIH, or more
commonly called “Pregnancy Induced
Hypertension.” Basically, it’s high blood pressure as
a result of the pregnancy. It can be cause for
concern, as it can lead to (and is usually a precursor
to) preeclampsia, a condition that can be dangerous
for both mother and baby. Fortunately, mom had
been taking blood pressure medication to control the
condition since we discovered it early in the
pregnancy, and it was pretty well controlled
throughout the course of the pregnancy.

Because of the PIH, the OB/Gyn doctor scheduled
an induction (where they “force” or nudge the
delivery along) for Friday, August 12. The doctor also
said she’d be surprised if we made it to Friday. The
baby’s gestational age at the time of induction would
be 38 weeks and 1 day. Uhm … we made it all the
way to Friday without going into labor.

So, early on Friday morning, the three of us –
myself, Laura and Ryan – dutifully were at the
hospital at 6 a.m. By the time we got to the labor and
delivery room, it was 7 a.m. (SO much paperwork!).
The nurses started an IV to run the pitocin in with.
Ryan, having endured – like a champ, I might add –
the hour long paperwork BS, was getting a bit antsy.
So, I took him on a walk so he could get out of the
hospital room and see some different scenery.

Before we left on our walk, a call was placed to the
anesthesiologist to place the epidural catheter for
pain management during delivery. When we asked
who the anesthesiologist was, my wife and I both
rolled our eyes. We both used to work at this

hospital, know this man well, have dealt with him a
lot, and knew that he (or his associates) would be a
while showing up.

However … the OB/Gyn showed up before the
anesthesia folks, so the epidural catheter had not
been inserted yet. Ryan and I were still taking our
walk. Dutifully, the OB/Gyn broke the water. What
happened next happened VERY, VERY fast.

Finally, the anesthesia folks show up. One CRNA
(certified registered nurse anesthetist) and a trainee.
Great! Once the water was broke, contractions
started coming very quickly and very hard. So,
here’s my wife, enduring not only frequent and hard
contractions, but also enduring the anesthesia folks
poking around on her back, trying to place the
epidural catheter.

Unfortunately, the medication they run through the
epidural takes about 10 to 15 minutes to take affect.
Things are progressing VERY fast at this point. The
epidural didn’t kick in until the last two pushes of the
delivery.

With only 10 minutes of “hard pushing,” Alexandra
Emily Arnote was born on August 12, 2016, at 8:36
a.m. Mom and baby are doing very well, and Lexi’s
big brother, Ryan, is already very smitten with his

From The Chief Editor's Desk
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new baby sister. Several times a day, he will walk by
and give her a kiss.

My son and mother-in-law had been “banished” to
the waiting room while they placed epidural catheter.
But things progressed so quickly, neither had a
chance to come back into the room for the delivery.
My mother-in-law said that our OB/Gyn doctor
walked past her in the delivery room, saying
“unbelievable,” over and over again.

My two week vacation also started with Lexi’s arrival.
I haven’t taken two weeks off from work at one time
since my son was born in 2013. (The U.S. is the
ONLY advanced country in the world where there is
no paid maternity or paternity leave. We have to use
“vacation time,” if we have it accumulated.).

Thanks to knowing when we were going to be
induced, I had already completed laying out the
cover for the September 2016 issue of The
PCLinuxOS Magazine ahead of time. I knew that
things would be hectic, and boy were they ever!

To top it off, the September 2016 issue marks the 10
year anniversary of The PCLinuxOS Magazine. 10
years is a HUGE milestone, for any publication. It’s
an even grander milestone for a community based
project run by volunteers from that community. This
month, we have several articles celebrating this
momentous milestone, in addition to the “regular”
stuff we usually have in each month’s issue. So

guiding this larger, milestone issue of the magazine
has created even more tasks for me to keep track of.

In just my family alone, August is a very busy month
with six birthdays (when you add in Lexi’s birthday).
My niece, my son, my daughter, mine, my great
niece, and my niece’s husband (my great niece’s
daddy). By the time you read this, all of those
birthdays will have come and gone. Hopefully by
then, things will start to slow down around here a bit.
And I have only hit the highlights here.

Until next month, I bid each of you happiness,
peace, serenity and prosperity.

Screenshot ShowcaseScreenshot Showcase

Posted by daniel76, on August 21, 2016, running Windowmaker.

From The Chief Editor's Desk
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by Paul Arnote [parnote]

On the morning of August 27, 2016, the PCLinuxOS
community awoke to this sad message on the
PCLinuxOS forum:

Hi, I am not exactly sure where to post this. I am not
Tara. I live next door. She left me all her stuff, and did not
believe in passwords.

I have read through a lot of this forum, and have seen that
our dear girl was well liked and imparted her wisdom
freely. I was never a member of this forum, but I did
introduce her to PCLinuxOS.

It is my sad duty to inform you that Tara's consistent
migraines were not caused by her love of Tequila or fine
Whiskey. Seriously, that girl could drink me under the
table. Unfortunately, she had a brain tumor, apparently
inoperable, and she passed away this morning.

It has only been hours, but I miss her dearly. I suspect
that many of you will too, even if you did not meet her in
person, she had a way making people feel like they knew
her.

I don't know what else to say. It was very unexpected.

If you didn't know, her birthday was November 6. I called
her "Gall Faulkes, late for the party." We went to the
same high school, Grove Park SS, Wrexham, aka
Wrecsam, now just called "The Groves."

Her last wishes were that she be cremated and her ashes
tossed in the Mersey. I promise, I will make it happen her
way.

Also too, for those of you who were fond of her, I have
many pictures of her with the Cessna, her Jaguar and her
motorcycles.

The above was posted at 00:34:56 (CDT). Just three
hours, 12 minutes, 16 seconds earlier, Tara Victoria
Rain made her last post to the PCLinuxOS forum.

As the day wore on, many PCLinuxOS users
expressed their sadness at hearing this unexpected
and jolting news. Condolences and other heartfelt
messages poured forth from many users.

Tara joined the PCLinuxOS forum family on July 15,
2013. Since that time, she made just over 1900
posts to the forum. In the short time she was a
member of the PCLinuxOS forum, she managed to
ingratiate herself to many forum members, becoming
a welcome and well loved member of the
PCLinuxOS family. While listing her age on her
forum profile as 355, she did mention a couple of
times in the forum that she was 28 years old.

The magazine staff had asked Tara on multiple
occasions to “volunteer” to be featured in the
magazine’s monthly “PCLinuxOS Forum Family
Member Spotlight” column that highlights and
features a different forum member every month.
Each time, Tara would turn down the invitation,
believing that there were others more interesting and
deserving than she was.

Included in Tara’s signature was an image from
DeviantArt artist and contributor ConceptsbyMiller,
called “Fairies Wear Boots Betty Page.” Betty Page
is a famous pin-up image, and the image is inspired
by a Black Sabbath song, called “Fairies Wear
Boots.”

Tara seems to have come to PCLinuxOS well versed
in the “Linux way.” Like many PCLinuxOS users, and
despite her forum “sign up” date, Tara alluded to
having run PCLinuxOS for a much longer period of
time. In a forum post from October 2013, Tara
indicated having run PCLinuxOS since October
2010. Elsewhere, Tara stated that she had been a
Linux user since 2006.

Originally from Wrexham, a town in Wales, Tara
appears to have made Ontario, Canada her home.
There, she provided support to a high school
computer class. They had previously purchased Dell
laptop computers for their computer lab. When she

In Memoriam: Tara-Rain-9.5ß

http://www.pclinuxos.com/forum/index.php/topic,138811.msg1186055.html#msg1186055
http://www.pclinuxos.com/forum/index.php/topic,138200.msg1185932.html#msg1185932
http://conceptsbymiller.deviantart.com/
https://www.youtube.com/watch?v=CY4dVyAl31g
http://www.pclinuxos.com/forum/index.php/topic,119354.msg1015192.html#msg1015192
http://www.pclinuxos.com/forum/index.php/topic,119354.msg1015192.html#msg1015192
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discovered that they were limping along with the
original Win2K that came installed on the laptop
computers, she sought permission to upgrade the
computers to a more modern operating system.
That’s right. She took it upon herself to upgrade the
computer lab computers to PCLinuxOS. Plus, she
provided any support they needed in keeping things
running in top form.

In another forum post, Tara provided the GPS
coordinates for where she was living, via
http://www.thegpscoordinates.com. Undoubtedly, the
students she was selflessly supporting are going to
miss her.

As I read through all of Tara’s posts (I started with
her oldest forum post and read them all backwards
in chronological order), I was amazed by several
things. First, I was amazed by the incredible breadth
of her knowledge. She exhibited more knowledge
than most seasoned Linux hands. Second, I was

amazed by how many people she helped (and
touched) in the forum. She lent a helping hand
whenever she could, and it was apparent that she
did so with a smile. She never talked down to
people. Third, I was quite taken by her sense of
humor.

Evidence of Tara’s knowledge of Linux came in
another, later post in October 2013, where she
shared the brilliant bash script she wrote to
periodically clean her system, instead of using
BleachBit.

Tara’s knowledge really shined through when she
wrote MyLiveGTK, a Gtk based GUI front end for
MyLiveCD. Once a scary excursion to the command
line for many PCLinuxOS users, MyLiveGTK
demystifies using MyLiveCD and makes it super
easy for anyone to remaster their PCLinuxOS
installation, regardless of their proficiency with the

command line. MyLiveGTK makes it a relatively
simple point-and-click task.

Further evidence of her knowledge of Linux is
evident on the web site that hosts Linux utilities that
she and some of her Linux friends wrote. She also
offered them up to PCLinuxOS, and allowed
PCLinuxOS to apply branding to them.

While she never made a formal introduction of
herself to the forum, she did occasionally stop by to
welcome other new forum users. Below is one
abridged example from June 2016, where she finally
revealed a bit more about herself.

Hi Ray, welcome!

I discovered Linux in 2006. Before that, I was an Atari
girl. The only version of Windows that I ever had was
Win98. The only reason that I had it was because
CoolEditPro II was not available for the Atari. Neither
was Sims2 or Heroes of Might and Magic III. Continue
laughing, but remember: I had fun!

When I moved to Canada, my neighbour was nice enough
to mow my lawn for me. He also showed me the only OS
that detected and configured itself to all my h/w out of the
box (seriously, I was painting my nails, it proudly and
efficiently did it's thing). This happened in Live Mode. I
immediately installed it and never looked back. Okay, I
did look back, but there was nothing to see there.

Despite the lack of a formal self introduction, Tara
quickly became a fixture in the PCLinuxOS forum.
She won folks over with her solid advice and quick
wit. Most people didn’t need a formal introduction,
and instead felt like they were talking to an old
friend. She had a way of putting people at ease. She
was knowledgeable and conveyed that knowledge,
without a hint of cockiness, sassiness or seeming
like an egotistical know-it-all. Tara simply “inserted”
herself into the PCLinuxOS forum family.

Tara will be greatly missed from the PCLinuxOS
forum. It is saddening that often those we want to

In Memoriam: Tara-Rain-9.5ß

http://www.pclinuxos.com/forum/index.php/topic,123071.msg1028064.html#msg1028064
http://thegpscoordinates.com
http://www.pclinuxos.com/forum/index.php/topic,122357.msg1022766.html#msg1022766
http://kotex.iwarp.com/
http://www.pclinuxos.com/forum/index.php/topic,138191.msg1181344.html#msg1181344
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stick around are taken from us prematurely. By Tara
leaving us so soon, it serves as a reminder to all of
us to not take our time among friends and family

lightly, and to make our best effort to leave the best
mark possible on our little corner of the world.

Tara, you will be dearly missed by all.

The PCLinuxOS Forum Reacts To The Loss Of Tara
Below is a sampling of the responses in the
PCLinuxOS forum, after hearing about the loss of
Tara Rains.

Maggie: Thank you for letting us know the
devastating news. I can't express myself well in
writing and won't even try… I'm really sad.

Not_yet_16: Thank you for taking the time to post to
let us know. That is appreciated. This is extremely
sad news, Tara was one of 'the family' and
contributed greatly to this forum. I, and I am sure
others, would appreciate it if you could post some
links to pics. Please also feel free to post some more
during these dreadful days while the full impact of
her loss hits home. Her software, myliveGTK, has a
permanent place in this distro, and every time it is
used she will be remembered. It is always upsetting
to lose a friend.

Old-Polack: Tara was an instant hit upon her arrival
here, and some of us felt very close to her. She was
so bright and talented, with a great sense of humor,
and quickly became both friend, and family, here.
Our dear girl, as you called her, is an apt and fitting
description. I will miss her terribly. I think I speak for
most of us here when I say that any stories you
would wish to share, about happy memories you
shared with Tara, would be well received and greatly
appreciated.

tbschommer: I am truly devastated, losing such an
integral part of the family.

Archie: I am saddened Tara can no longer be with
us. She was a part of our big family, and she will be
sorely missed. Rest in peace, fairy. I've never seen a

glimpse of her and I know I'm not alone who'd want
to see who she was. Please post some of her
photos. That way, we'll have a face to remember her
by. And thank you for taking time to inform us of the
sad, sad news.

TerryN: I keep checking the calendar hoping to find
that it is April 1st today but to no avail. So sad to
hear this news; I am lost for words. Sincere
condolences to those who knew Tara in the "real
world".

MGBguy: Over the years I have come to appreciate
many members in the PCLinuxOS community. Tara
was one of the "personalities" whose knowledge and
good humor distinguishes this forum from so many
others. Her passing saddens me.

Frazelle09: Wow. This is really sad. Thank you so
much for posting this as well as whatever
information you felt you could share. She was a
wonderful member of our community and we will
miss her greatly.

TerryH: After seeing the title of the post and having
read the first paragraph numerous times, it is so
saddening to read this terrible news. She will be
sadly missed. RIP TaraRain.

YouCanToo: This truly saddens my heart. This is
another blow this year for the friends and family I
have lost. We will surely miss you Tara with the
laughter and knowledge you brought to the forum.
May you find peace in your journey.

joechimp: Today the news has brought a tear.
News like this, is our biggest fear.

We have no answers..... there are none.
Tara would say let's have some fun.

I did not know her, yet she made me smile.
She had a way, she had some style.
We will remember, for time to come.
How we wish it could be undone.

Maurice: On a dull and cloudy winter's day a
cheerful post from Tara was a real ray of sunshine.
She will be so sadly missed.

Texstar: The news of Tara passing just breaks my
heart. She was so young and full of life. What a sad
sad day.

Pinoc: Totally shocked about this terrible news. I
loved to read her posts, full of knowledge, great
humour, joy, and fun. She will be greatly missed by
all of us. RIP Tara.

GOTHBITES: This is so sad. She is but a single
shining soul now departed to from our mortal coil too
soon for some.

tuxlink: While I didn't know her well, her name on a
post at least meant that you had been contacted by
someone who was really knowledgeable and very
helpful. I had loaded her .ISO BabyMate and it is still
running flawlessly today. What a really sad day for
all of us here at PClinuxOS. Truly, a beloved family
member sadly and sorely missed. RIP Tara Rain.

Andy Axnot: This is very sad news indeed. Tara
was a special person on this forum; very bright,
knowledgeable, helpful, and often very funny. As
others have said, she will be sorely missed.

In Memoriam: Tara-Rain-9.5ß
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by Paul Arnote (parnote)

It all started 10 years ago for The PCLinuxOS
Magazine. It went like this, with an August 30, 2006
announcement on the old MyPCLinuxOS.com
projects website.

PCLinuxOS Magazine September 2006 Initial Issue

It is my privilege to announce on behalf of the team
members of the PCLinuxOS Magazine Project sponsored
by MyPCLinuxOS.com, the September 2006 introductory
issue is available for download! We've put a lot of effort
into producing a quality magazine made for the
community, by the community.

Contained inside are many articles written for the
PCLinuxOS community and a few for those interested but
not yet using it. Some highlights include:

1. An interview with Susan Linton of Tuxmachines.org

2. An RPM Tutorial for beginning users

3. Hunting rootkits with Rootkithunter on PCLinuxOS

4. Much, Much more!

Please note that the magazine is released under the
Creative Commons Attribution-NonCommercial-
NoDerivs 2.5 license unless otherwise stated on the
articles themselves. By downloading this magazine you
must acknowledge and accept this license agreement.

We've released the magazine in two versions in pdf
format. We designed the magazine for viewing in KPDF
but other viewers will work as well. The two formats of
the magazine are Viewer Default (VD) and Presentation
Mode (PM). Viewer default will display the magazine in

the default mode your reader is setup with and
Presentation Mode starts in full screen.

PCLinuxOS Editor-In-Chief, Archie, has further
explanation of the downloads:

"The following files are best viewed in KPDF. Other
readers, such as Adobe Reader, Ghostview, XPDF can

also be used. The following instruction is based on using
KPDF.

PCLinuxOS_Mag_200609_PM.pdf is initially in
presentation. Moving pages forward is as easy as clicking
the left mouse button. To go back a page, the user just
right-click the mouse button. And exiting the Presentation
Mode is not harder than pressing the ESC key.

The PCLinuxOS Magazine: 10 Years Old
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A user can also hover the mouse cursor on the top of the
screen and there will appear some navigation buttons. On
the top left-hand side are the blue forward and back
buttons; on the right-hand side is the exit button."

Head over to the downloads section to download the
latest issue of the magazine. Thanks for your interest in
PCLinuxOS! If you feel you'd like to contribute to future
issues, please check out the contribute link in the main
menu. You can also drop us a line via the contact link in
the main menu. If you have any suggestions, comments,
or letters to the editor feel free to submit them this way or
send an email to mag@mypclinuxos.com. Thanks and
enjoy!

PCLinuxOS Magazine Download
(link changed to reflect current download URL)

This announcement is all that remains of the
discussions surrounding the first edition of The
PCLinuxOS Magazine, and we only have that,
thanks to the Internet Archive’s Wayback Machine.
The rest of it has been long lost in the great digital
ethernet, including (unfortunately) the discussions
that lead up to the magazine’s creation. Most likely,
those discussions fell victim to numerous forum
software changes on the MyPCLinuxOS.com project
site. Only the memories and reminiscing of the
individuals involved remain, and most of those
individuals have scattered to the wind as they went
about their way and moved on from PCLinuxOS.
There are only a handful of individuals remaining
from the time of the magazine’s first issue, namely
Texstar, Not_Yet_16, jaydot, Archie and Neal
ManBear.

Of those who remain, Not_Yet_16 (then known as
ClareOldie) remembered the magazine’s beginnings
like this:

The thing I most remember about the process is the
emphasis on quality that was engendered from the very
beginning.

Each submitted article was checked and edited for
technical accuracy in the first place, and then went
through at least three further checks & edits. These
further checks were to ensure that the written article did
not contain any spelling or grammar errors etc., but also
to allow parts to be re-written for clarity if necessary.
These checks were carried out by different proofreaders.

Of course the 'finished' article then had to have a final
check for accuracy (to ensure the edits did not change the
meaning of anything). Finally the writer of the submitted
article had a chance to proofread before publication.

All articles, including the editorial, went through this
process.

I believe it was this 'belt & braces' process that ensured
the magazine, from the very first issue, was as good as it
could be and much better than similar projects of the time
(which have since faded away).

Congrats to all involved for maintaining the very high
standard set from the beginning. Ten years is quite the
achievement.

ClareOldie

In those days, the articles were submitted in
OpenOffice *.odt format. Today, the magazine
articles are all in Google Docs. Even articles that are
submitted to the magazine in .odt format are placed

into Google Docs. This allows for collaborative
editing by the magazine staff. Sometimes, even
multiple magazine staff members are editing the
same article at the same time. This not only
facilitates openness and transparency, but it is a lot
more efficient than emailing files back and forth –
and hoping you have the most recent version. The
use of Google Docs dramatically streamlines this
whole process.

Today, “we” (The PCLinuxOS Magazine) will accept
article submissions in any format you want to submit
it in. Aside from Google Docs, we’ll accept articles in
LibreOffice *.odt format, AbiWord, in a *.tar.gz file
that contains an annotated text file and pictures, or
on paper napkins with stick figure drawings. All of
them will be transferred to Google Docs by the
magazine staff to facilitate the collaborative editing
environment that we have all become accustomed to
on today’s magazine staff.

The changing of the “guard”

Archie served as the magazine’s first Chief Editor, as
well as the Chief Editor for the magazine’s relaunch
in July 2009. (Be sure to check out Archie’s
companion article in this issue, remembering how
the magazine first came about.) The reins were then
handed over to Tim Robinson. When Tim’s health
started to give him issues, he handed over the reins
to a very capable John Paxton, a.k.a. Papawoob.

Previous editors, from left to right: Archie, Tim Robinson, Papawoob, and historyb.

The PCLinuxOS Magazine: 10 Years Old

http://pclosmag.com/download.php?f=2006-09.pdf
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Like his predecessor, Papawoob also encountered
some health issues after about a year, so the Chief
Editor position was handed over to Doug Wilson,
a.k.a. historyb.

Editor’s note: Attempts were made, unsuccessfully, to
contact Tim Robinson and Papawoob for this article. Our
emails were not returned, so their whereabouts and
welfare are not known. No attempts were made to contact
historyb, for reasons you’ll come to understand below.

Also, the information immediately below isn’t presented to
reopen old wounds. Rather, it is a part of the history of
PCLinuxOS and The PCLinuxOS Magazine. As such, it
deserves coverage and remembering just as much as the
successes of PCLinuxOS and The PCLinuxOS Magazine.
After all, those who don’t learn from history are bound to
repeat it.

For the first few issues, things went reasonably well
for the magazine under historyb’s leadership. But
then the monthly deadlines and release schedules
were beginning to be missed. So, historyb took it
upon himself to change the magazine’s publication
schedule to quarterly. He covered it by claiming that
there simply wasn’t enough to talk or write about.
The general consensus at the time was that one
large quarterly magazine was better than no
magazine at all, so the community more or less went
along with the quarterly release schedule.

That lasted for one quarterly issue before the
second quarterly issue missed its scheduled release
date. A couple more months (past the scheduled
second quarterly release) went by before the
PCLinuxOS community saw another release of the
magazine released. That “special issue” was done
primarily because enough articles had been
submitted and amassed to warrant the publication of
another issue.

Around the same time, there was a bit of turmoil
among those who were given the task of
safeguarding and maintaining PCLinuxOS, since
Texstar had taken a sabbatical for health reasons. A

“messy” February 2009 release, coupled with some
questionable “behind the scenes” antics prompted
Texstar to return early from his health sabbatical to
take the lead in righting the ship. Things were said,
feelings got hurt, and a group of packagers left to
create their own distro, which they called “Unity
Linux” (which never really saw any significant
success for a number of reasons).

A “mutiny” of sorts ensued, and some regular users
decided to follow the packagers who left to form
Unity Linux. When the “special issue” of the
magazine came out, the predominate (and often
repeating) ad in that issue was for TinyMe, a
stripped down, very small version of PCLinuxOS.
Except, TinyMe was no longer an official PCLinuxOS
release, especially since its maintainer was one of
those who left for Unity Linux. When asked by
Texstar to replace the ads, historyb refused. Instead,
historyb tried to claim ownership of the magazine
and attempted to kill the magazine off. Texstar
ended up replacing the ads himself, and historyb
fled to Unity Linux, as well.

The initial discussions involving the release of the
“special issue” and historyb’s attempts to kill off the
magazine were open and public in the PCLinuxOS
forum. I happened to be on the forum that morning
when the shiitake mushrooms hit the fan, and I
remember the exchanges as if it were yesterday.
After a while, those heated exchanges were moved
to a more secluded section of the forum that wasn’t
in public view.

As you might expect, the incident with historyb left
Texstar “once bit, twice shy” in the trust department.
For the next few years (yes, years) I would have to
submit the monthly magazine to Texstar for his
approval, before releasing it. Once we re-
established trust with Texstar, that requirement was
lifted and we could release on our own without prior
approval.

Since then, we have maintained not only a monthly
magazine – with over 14,000 packages in the repos,

there is plenty to write about, if you just look hard
enough – but we have also put out several “special
editions” of the magazine.

Next in the evolving saga involved “negotiations” for
the MyPCLinuxOS.com site, since the person who
was hosting it – and who owned the domain name –
was one of the Unity Linux defectors. The magazine
also made its home on the MyPCLinuxOS server.
Weric, who used to sell computers with PCLinuxOS
already installed and configured through his
company named LinPC.us, agreed to host the
MyPCLinuxOS.com site, along with an expanded
site for the magazine. (The site is still up, but does
not appear to have been updated since sometime in
2015; thus, it’s likely that the products listed can no
longer be obtained or purchased).

After a few years, Weric found himself in a position
where he could no longer host MyPCLinuxOS.com,
nor the magazine website. So, YouCanToo took over
both domains and the hosting duties on his servers.
The MyPCLinuxOS.com forum had already been
shut down and discussions about development and
special projects had already been moved to the
main PCLinuxOS forum. The magazine’s separate
forum was shut down at this time, and discussions
pertaining to the magazine were transferred
exclusively to the main PCLinuxOS forum, as well.

The April 2012 move from Weric’s server, where the
magazine site used Joomla CMS software (we
“inherited” it that way), gave us the opportunity to
revamp the magazine’s website. While we looked at
WordPress to replace Joomla, the ultimate decision
was made to forego the use of any CMS (content
management system) software, opting instead for
just plain HTML. Since updates only occurred to the
magazine website once or twice a month, use of
CMS software seemed like overkill. As the Chief
Editor, one of my responsibilities is updating the
website every month (except for the HTML version
of the magazine issues, which YouCanToo lays out
and takes care of uploading). I can attest that it
involved a LOT more work to update the website

The PCLinuxOS Magazine: 10 Years Old



PCLinuxOS Magazine Page 11

under Joomla than as plain HTML. Plus, the website
also loads a lot faster with plain HTML – and
especially without the overhead of CMS software.

PDF, HTML and more

From the start, the magazine has been published
both as a downloadable PDF, and as HTML pages
for online access. Under my tenure as Chief Editor,
most of the PDFs have been created by me and
Meemaw, using Scribus. In the very early days,
former assistant editor Andrew Strick also helped
with layout. Ms_meme lays out her own pages,
which we insert into the PDF during final layout.

The HTML pages have been under the oversight of
four different individuals during my tenure. Initially,
gseaman managed the HTML edition. When he was
unable to continue doing the HTML pages (due to
other commitments in his life), Sproggy took over.
Rudge took over the HTML pages when Sproggy
had to step back. Today, the HTML pages are
managed and laid out by YouCanToo. We
streamlined and simplified the HTML pages when
we revamped the magazine website in April, 2012,
enabling much faster layout. Faster layout helps us
to better meet our release dates, so everyone wins.

Starting in May 2012, YouCanToo has produced
ebook versions of The PCLinuxOS Magazine. He
produces both MOBI and EPUB ebook versions,
enabling the magazine to serve the vast majority of
ebook users, regardless of which platform they are
using.

Superman in our midst …

I was initially familiar with YouCanToo from the time I
spent in the PCLinuxOS forum. What I didn’t
appreciate – and didn’t know – at the time was the
remarkable breadth of his knowledge, skills and
capabilities.

YouCanToo

Around PCLinuxOS, YouCanToo truly is our
Superman. I’m going to try to give a rundown of the
things that he does.

* Maintain the master PCLinuxOS repository server,
against which all the other mirrors sync.

* Maintain and host the magazine’s website.

* Create and maintain the magazine’s HTML version
every month.

* Create the magazine’s ebook files every month.

* Write occasional articles for the magazine, produce
the monthly PCLinuxOS Forum Family Member
column, and produce his monthly recipe columns.

* Host and maintain the servers for PCLOS-Talk, the
live chat service only for PCLinuxOS users.

* Host and maintain the servers for PCLOS-Cloud,
the cloud service only for PCLinuxOS users.

* Host and maintain the servers for MyPCLinuxOS,
which includes a photo sharing site and private
email service, only for PCLinuxOS users.

The PCLinuxOS Magazine: 10 Years Old
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* Host and maintain the PCLinuxOS Knowledge
Base wiki site.

* Creator of the ChimpBox, a top notch computer
assembled (and sold) with PCLinuxOS preinstalled
and preconfigured.

As you can see, YouCanToo does some real heavy
lifting not only for PCLinuxOS, but also for The
PCLinuxOS Magazine. Quite frankly, I don’t know
where any of this would be with him. I know I tell him
“thank you” all the time, but it really doesn’t seem
sufficient.

Like I said … YouCanToo is OUR Superman.

Many contributors

I’d also like to take a moment to thank all of those
who have contributed to The PCLinuxOS Magazine.
Like with any Linux distro, people come and people
go. Some move on to other adventures, others find a
“home” and stay for a while, becoming a part of our
PCLinuxOS “family.”

It’s a very similar situation with The PCLinuxOS
Magazine. Many, many contributors have helped
shape the magazine. Some contribute one or two
articles, while others have contributed to the
magazine for years on a very regular basis.

You probably know many of the names: ms_meme,
georgetoon, daniel, Neal ManBear, jaydot,
Not_Yet_16, loudog, critter, longtom, Hootiegibbon,
Sproggy, cstrike77, Rudge, joechimp, YouCanToo,
Archie, Rodney Adkins, and many, many others.
Some are still with us, while others have moved on
to other pastures. There are way too many to list
here. Each and every contributor helps shape the
magazine. Whether I listed your “name” or not, your
contributions to the magazine are highly valued, and
I thank each and every one of you.

Meemaw

One special contributor is Meemaw, the magazine’s
assistant editor. Quite frankly, I doubt I’d be able to
do this or even still be here in this position without
her. Besides being a regular, monthly article
contributor, she helps with the layout of the articles
for the PDF, and does the final assembly of the
magazine every other month. Add in helping
proofread each and every article that appears in the
magazine. Thank you, thank you, thank you a
gazillion times for all that you do (and for putting up
with me!).

Summary

The PCLinuxOS Magazine has always been
produced as a magazine of the community, by the
community, for the community. Of course, that
community is PCLinuxOS. Quite simply, The

PCLinuxOS Magazine belongs to YOU! We are only
its caretakers, its stewards.

At the same time, we strive to bring you a first rate,
first class magazine that hits on topics that are of
interest to PCLinuxOS users. The magazine is also
an ambassador of sorts, introducing PCLinuxOS to
those who don’t use it or who aren’t familiar with it.
We are fully aware that non-PCLinuxOS users also
read the magazine. I’ve heard and seen comments
on other forums in Linux Land.

None of us who work on the magazine get paid, at
least in the traditional monetary sense. We all have
paying jobs that put a roof over our heads and food
on our tables. We all have families and other “life”
responsibilities. Instead, for us, it’s a labor of love,
and it’s one way we can give back to the PCLinuxOS
community.

A 10 year milestone is a huge accomplishment for
any publication. It’s an even bigger accomplishment
for a completely free community based magazine,
produced by volunteers from the community. As
community projects go, most wither and die on the
vine. People lose interest, move on to other projects,
it turns out to be more work than they originally
thought, etc. The PCLinuxOS Magazine is an
exception to that, we feel. Because of that, it must
go on. If there’s something you want to see in the
magazine, or a direction you want the magazine to
go in, YOU must let us know. Or, you could join the
magazine staff and help us attain those goals. Even
better yet, you could write articles for the magazine
(we can’t possibly think of everything on our own).

So, here’s to looking forward to the next 10 years of
The PCLinuxOS Magazine. The faces and names
may change, but we will always strive to produce a
magazine that the PCLinuxOS community can be
proud of.

The PCLinuxOS Magazine: 10 Years Old
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Every song every note
Every poem I wrote all true
Every rhyme that I made

Every tune that I played for you

Of my life you're a part
Hold you dear to my heart
It can really make me cry

And like before
I'll be singing for you more

So many years ago
When I was young my friends

I joined the forum like you
When I sing my songs

I hope it makes you smile

They've been such happy times
I always felt a glow

Oh where did the time go
But I'll never forget

Mem'ries with me yet
I want you to know

So many years ago
When I was young my friends

I joined the magazine
And the fun I've had

It's all been worthwhile

I love singing my songs
For PCLinuxOS

And the friends I find there
The help that you give

Always positive
I really know you care

MP3 OGG

ms_meme's Nook: I'll Be Singing For You More

http://pclosmag.com/html/Issues/201609/files/illbesingingforyoumore.mp3
http://pclosmag.com/html/Issues/201609/files/illbesingingforyoumore.ogg
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Screenshot ShowcaseScreenshot Showcase

Available in the following desktops:

KDE LXDE Xfce

Openbox Gnome

Enlightenment e17

Posted by davecs, on August 7, 2016, running LXQT.

http://www.pclinuxos.com
http://pclostalk.pclosusers.com
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Hamburg Steak (pronounced hahm-bah-goo in
Japan) is probably the most popular bento lunch
entrée in Japan.

Ingredients

1 large Egg
1 small Onion(finely diced)
1 large clove Garlic(minced)
1 Lbs. Ground beef
6 Ozs. soft Tofu
1 cup Panko
2 tablespoons Ketchup
1 tablespoon Oyster sauce
1 tablespoon Parsley(minced)
1 teaspoon Soy sauce
1/4 teaspoon Black pepper
1/2 cup Dry red wine
1/4 cup Ketchup
1/4 cup Water
2 tablespoons Tonkatsu sauce

(Worcestershire sauce also works)
1 tablespoon Demi-glace(optional)

Directions

1. Add a tablespoon of vegetable oil to a frying pan
and sauté half the onions and all of the garlic until
medium brown and caramelized. Let these cool to
room temperature.

2. Combine the beef, tofu, sautéd onions, raw
onions, panko, egg, 2 tablespoons of ketchup,
oyster sauce, parsley, soy sauce and black pepper

in a large bowl. Put some food-safe gloves on and
knead the mixture together until it is uniform in color
and texture.

3. Add a little bit more oil to the frying pan that you
fried the onions in and place over medium heat.
Because the patties are on the soft side, you'll want
to form them and add them directly to the pan. I
usually make about 8 oval patties about 1" thick.

4. Fry them until they've formed a dark brown crust
on one side, then use a spatula to carefully flip them
over and brown the other side. Unless you have a
very large pan, you won't be able to do them all at
once, so fry 4 at a time and transfer them to a plate
when they're browned on both sides. Don't worry if
they're not cooked all the way through as they will
finish cooking in the sauce.

5. After you've fried all the patties, drain off any
excess oil (but don't wash the pan as the brown stuff
is what will give your sauce flavor). Add the red wine
and boil until it's reduced by about half in volume.

Add the ketchup, water, tonkatsu sauce, and
demi-glace and stir to combine.

6. Place the patties back into the pan, cover,
and cook for 7 minutes, flipping them over once
in the middle. Cook uncovered for another 3
minutes to thicken the sauce a little. Serve with
rice, pasta or boiled potatoes.

The PCLinuxOS
Magazine

Created with
Scribus

PCLinuxOS Recipe Corner

Japanese Hamburger Steak

http://www.dosgamesarchive.com/
http://www.scribus.net
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By Meemaw

Wow, ten years! It doesn’t seem like that long – but
then, time seems to go faster when you’re older. I
am honored to have been with the magazine staff
almost that long.

I honestly don’t remember any of the discussion that
went into the start of the magazine, being a brand-
new PCLinuxOS user and trying to learn all I felt I
needed to know. I do remember reading the first few
issues when they came out, and thinking that they
were informative and great for anyone using this
distro.

After a few issues came out, Chief Editor Tim
Robinson sent out a request in the forum for
proofreaders. Since I had been a teacher for twenty
years before moving to my current job, I felt that I
was qualified to proofread. I was sure I wasn’t
experienced enough yet to instruct anyone in how to
accomplish something, but I was sure I could check
articles for spelling and grammar, so I sent him a PM
and agreed to proofread. Back then, we received an
email with the document attached, and we did the
edits and sent it back to Tim for review. I often
wondered how hard this was for Tim, having emails
zoom in and out all month, and having to keep track
of them all.

I did, finally, summon the courage to write and
submit an article. It was about creating your own
favorite programs menu in KDE, in the April 2007
issue. I use Xfce now, but I still have a favorites
menu.

In September 2007, Papawoob became the Chief
Editor. He and Tim were both very easy to work for,
and unfortunately, both resigned from the position
due to health reasons. I always wonder how they are
and hope that their situations are improved.

In September 2008, Doug became the new Chief
Editor, and while he was very nice to me, I began
noticing some things that bothered me. First, I
noticed that even though I had edited an article for
spelling and grammar, it would be changed back or
the original version used in the final assembly. That
disturbed me because I couldn’t see why I worked
so hard on proofreading if the final wasn’t going to
have the corrections. In January 2009, he
announced that we would only be releasing the
magazine every quarter. I also was asked to design
a cover to go with the next issue, which would
include parnote’s excellent article about PCLinuxOS
And Your Blackberry. I was surprised when it wasn’t
released until June! By this time there was trouble
brewing behind the scenes at the forum (which other
articles in this issue can cover better than I can). In
my naivety, I just wanted everyone to get back to
working together nicely, but that wasn’t to be. Doug
left, and so did the Unity Linux guys. I decided I
would back off from the magazine until things
quieted down a bit.

I was off the staff for two months, during which
parnote kept asking me to come back. Since July
and August are my busiest months at work, I was
glad to have the break, but went back to
proofreading in time for the September issue. I also

found that parnote had changed the editing process
over from OpenOffice documents being emailed to
Google Docs, where everyone could view the article
and make corrections if needed. This seemed to me
to be much easier.

I’ve been on the staff ever since, even accepting the
Assistant Editor position in March, 2012 when
Stricktoo left to pursue his law degree. Actually, I
became one of the co-Assistant Editors in August
2010, since Andrew was so busy with law school.
Eventually, I became the only Assistant Editor. I’ve
also been a regular contributor since September
2009, doing several series of articles on various
subjects, including photo viewers, financial
programs, OpenOffice/LibreOffice, Scribus, and
GIMP and Inkscape tutorials. I have even designed
many covers and created most of the puzzle pages.

I love working for the magazine, but I think my best
place is Assistant Editor, because parnote is a
wonderful leader for us all. I don’t think I could do
even half of the great job he’s doing if he ever left!
I hope we can continue for many more years!

PCLinuxOS Magazine: Memories

http://pclosmag.com/html/Issues/200704/page03.html
http://pclosmag.com/html/Issues/200704/page03.html
http://pclosmag.com/html/Issues/200906/page05.html
http://pclosmag.com/html/Issues/200906/page05.html
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by Khadis

Creating a 3D photo using image editing software
isn’t something new. How about if we create it using
Inkscape? It is totally easy, and can be done in
minutes. Let’s start!

1. Create the following shapes. You can use the
rectangle tool (F4), or manually draw them using the
Bezier tool (Shift + F6).

2. Arrange those object like this:

3. Import a grass image. I took a random image from
Google Images. Put the image behind the first
shape. If the image isn’t behind the first shape yet,

press Page Down once, twice, or many times until it
moves behind the first shape. Press Page Up to
return it to upper position.

4. Select the grass and the shape, then go to Object
- Clip - Set. The grass image should now fill the
shape.

5. Import a soil texture image in PNG format. Again, I
took randomly from Google Images. Before you put
the image behind the second shape, it is better for
you to duplicate the image (Ctrl + D) so we do not
need to re-import the image to fill the third shape.

6. Put the first soil image behind the second shape
like in the step #3. Select them, then go to Object -
Clip - Set.

7. Before doing the same step to the third shape,
let’s make the second soil image darker than the
first.

8. Select the second soil image, go to Filters - Color
- Lightness-Contrast. Set the lightness lower than
the original value (make the image darker). Check
the Live Preview to see the changes, then click
Apply once you are satisfied with the darkness
level.

9. Put this second soil image under the third shape,
then go to Object - Clip - Set.

10. Now, import some rock and tree images in PNG
format. You can easily find them in Google Images
using a search keyword like “rock png”, “tree png”,
or something like that.

11. Arrange those rock and tree images. Mine is like
this (next page, top left):

12. Later, you can add a lake, pond, or river, or even
buildings. I added a pond by creating it manually,
using the Bezier tool (Shift + F6). (center left)

13. Then place a water image using Object - Clip -
Set action. Again, I took the sea water image from
Google Images.

Inkscape Tutorial: Create A 3D Landscape
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14. The final result might be like this:

Screenshot ShowcaseScreenshot Showcase

Posted by martinh, on August 9, 2016, running e21.

Inkscape Tutorial: Create A 3D Landscape

http://pclostalk.pclosusers.com
http://pclinuxoshelp.com/index.php/Main_Page
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by Archie

Ten years ago this month, PCLinuxOS launched
its first magazine issue, and as history would write it,
PCLOS became the first ever independent Linux
distro ever to publish an online magazine. The
period of formation and organization leading up to
September, 2006 was even more memorable. But
the excitement and intrigue didn't stop there.

Oh, the magazine didn't just appear from a
Linuxverse black hole, it was lovingly conceived, and
it was given birth. In a coconut-size shell, the
magazine was initially brewing and percolating in
brilliance both within the PCLinuxOS Support Forum
and the now defunct MyPCLinuxOS forum. Then, as
it is with the life of a growing young child, it struggled
with a tumultuous wrangling of identities. Finally, as
we are now witnessing its stability and maturity, the
magazine has found its rightful place amongst many
of our hearts with many of our forum members
actively participating in its compilation of useful and
helpful articles month after month.

Here is one of its first stories from the magazine's
first chief editor. It began a long, long time ago in a
Linux galaxy far, far away when an arrogant Linux
user hopped into the PCLinuxOS Support Forum
from Ubuntu's searching for love and affection. Little
did that user knew how much for the better his Linux
experience would change. A prior year-and-a-half of
using Linux and he thought he knew everything so
he started throwing wild and crazy ideas of all sorts
of projects around at the forum – it's simply what he
does best. He garnered the attention of several
forum members who thought the noble idea of a
magazine was to say the least, interesting. Come to
think of it, the first issue was more of a ragtag
binding of brochure clippings than anything else. But

when the date to announce the release of the first
issue arrived, it was with the greatest of pride that he
celebrated this PCLinuxOS milestone, as surely did
many others like himself.

That chief editor wasn't really taken to the ideas of
the responsibilities and commitment which goes with
the running of a magazine operation, so as quickly
as he could type “third issue” on his Konsole, he
handed the management and editorial
responsibilities to the more capable hands of the
magazine's second chief editor, Tim Robinson.

Tim goes by the handle, trobinson, an all-around
great guy, and like many more of the forum

members back then, he is no longer active and his
account registration seems to be have been weeded
out years back. He was, however, a much more
responsible chief editor than his predecessor was.
He had under his hat volumes upon volumes of
issues supported and contributed by forum
members. The psychological stage of the magazine
during Tim's era was that of a toddler learning to
walk.

But like most families, PCLinuxOS has seen a
handful of ups and down, which, if memory serves
me right, is a pinpoint accurate statement by
Texstar's “roller-coaster ride” … often smooth, and
every now and then, a wild and scary experience!

A Look Back At The Beginning:
A View From The First Editor



The magazine was never an exception and when
Tim’s health started to be a problem, he handed the
management of the magazine to Papawoob, but he
and his wife were both having health problems. So
shortly afterwards, Papawoob handed it over to
historyb, aka Doug. It was at the time when
dissension among the PCLinuxOS developers was
boiling, and spoiling the updates. What it was about
is for another story but let me tell you this, the
circumstances are pretty similar to what one group is
now doing with the 32-bit. People don't seem to
learn from history!

Anyway, the magazine was akin to a teenager who
couldn't decide whether he wanted to be a know-it-
all punk or a smart, learning individual. So when the
inevitable happened, the then-chief editor supported
the other group of developers and hijacked all the
contents and resources of the PCLinuxOS
magazine, claiming everything about the magazine
was his. The project was single-handedly shut down!

The first chief editor was really offended by the
plagiaristic claims and stepped in to negotiate the
release of the magazine site and the removal of
Doug. The negotiation with the then owner of the
magazine's domain was amicable and a resolution
was immediately reached with the help of some
forum members. Weric, former proprietor of LinPC
(which sold computers preloaded and preconfigured
with PCLinuxOS), agreed to host the magazine site
and all of MyPCLinuxOS on his servers. Parnote
expressed his unequivocal intention to head the
magazine. YouCanToo took over the hosting duties
that Weric had been handling when Weric found
himself unable to continue to host the various
websites.

All well and good, one might think. Well, not quite.
The reorganization of the magazine took a bit more
effort to recover. Planning the symbolical re-launch
with the original chief editor seemed like a good
idea. Parnote, our current and longest-running chief
editor can attest that with the resurrected
PCLinuxOS Magazine, the process in which the

magazine was glued together had to be quickly
adapted and improved. To make the process more
open and transparent, article submissions switched
from OpenOffice documents (at that time) to using
Google Docs. This allowed instant collaborative
editing that included all of the magazine staff,
instead of sharing files back and forth via email.

Now, all seems quiet on the magazine's virtual HQ,
but from what I have seen in the many years that the
magazine continues to grow, it is in very capable
guidance and I have no doubt it will continue to
develop and mature under its present team.

Lastly, let me congratulate everyone involved with
the magazine, whether you are a one-time
contributor or a regular, or whether you are one of
the crew – past or present, my sincerest and
deepest gratitude for the PCLinuxOS magazine's
celebratory 10-year anniversary, and thank you to
Texstar and all the PCLinuxOS developers for your
continuous support and friendship. I’m looking
forward to the next 10 years!

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

Donate NOW

A Look Back At The Beginning: A View From The First Editor

http://www.gofundme.com/pclinuxos-2016
https://www.edx.org/course/introduction-linux-linuxfoundationx-lfs101x-0#!
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Editor’s Note: Tip Top Tips is a new monthly column in The PCLinuxOS Magazine. Each
month, we will feature – and possibly even expand upon – one tip from the PCLinuxOS
forum. The magazine will not accept independent tip submissions specifically intended for
inclusion in the Tip Top Tips column. Rather, if you have a tip, share it in the PCLinuxOS
forum’s “Tips & Tricks” section. Your tip just may be selected for publication in The
PCLinuxOS Magazine.

This month’s tip comes from PCLinuxOS forum member `ĦξŘŤζ_.

You can use xscreensaver (with KDE 5) if you like:

1) Install xscreensaver and any extra modules you want. This should give you a
"Screensaver" entry in System Settings. The command it runs is "xscreensaver-
demo," which opens the settings dialog.

2) In System Settings/Startup and Shutdown, click "Add Program" and enter
"xscreensaver -no-splash." This starts the screensaver daemon when you log in.

3) Set a keyboard shortcut to transform your screen into a thing of beauty.

In System Settings, go to Shortcuts and click Custom Shortcuts.

Tip Top Tips: How To Activate
Xscreensaver On KDE 5 Plasma
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Click the Edit button and select New -> Global Shortcut -> Command/URL.

Name it "Screen Saver." Set the trigger to Ctrl+Alt+S or many keyboard
configurations, and the action to "xscreensaver-command -lock" (without
quotation marks).

Defending Your Rights

In The Digital World

Tip Top Tips: How To Activate Xscreensaver On KDE 5 Plasma

https://www.eff.org/
http://chimpbox.us
http://www.fsf.org
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by Meemaw

LibreOffice updates on a regular basis, the most recent update being to version
5.2 on August 3, 2016. As it generally is with PCLinuxOS and its wonderful
maintainers (thanks to everyone!), we had the update in our repo almost
immediately.

I thought it would be nice to review some of the newest features of this version,
so that when you get it installed (if you haven’t already), you’ll know what to look
for. LibreOffice’s Release Announcement has the following to start:

You can also enable the new Single toolbar mode in Writer and Calc, which has
the most-used tools on it, or stay with Standard mode. The way to do it is to click
View > Toolbars > Standard (Single Mode) and turn off the Standard and
Formatting toolbars by clicking View > Toolbars > Standard and View >
Toolbars > Formatting. While it seems a chore to do that for each program, it’s
wonderful that you can customize your single toolbar in each program so it has
exactly what you need.

OK, let’s look at some of the other additions listed above. If you have the
Drawing toolbar enabled (from the View > Toolbars menu), you will see the
buttons for the new drawing features. These should make for more variety in
whatever you need to draw.

I always wondered where “Print to File” was, since it seems to be a function in
most other programs. Now it is in LibreOffice as well (next page, top left).

If you use Google Drive, you already know that you have the feature to open
documents remotely in LibreOffice, as that was introduced in a previous version.

New Features of LibreOffice 5.2

• New drawing tools, including filled curves, polygons and freeform lines, have
been added to all program modules.

Writer
• When printing a document, Print to File is now available in the list of printers.
• If you use Google Drive for storage, two-factor authentication support has

been included.
• The Save toolbar button includes a quick Save as Template option, so you

don’t have to go through the menu.
Calc
• New functions have been added, along with extensive tooltips that describe

what a function does as you type it.
• Multiple status bar functions can be active at the same time, to provide a

quick overview of your data.
• The currency toolbar icon now includes a drop-down menu to quickly choose

the currency you want to use.
• When removing the border from selected cells, you can also choose to

remove the border from adjacent cells as well.
Impress
• When working with custom animations, you can now quickly add an effect to

an element via the sidebar, instead of using a separate dialog box.
• The list of effects in the sidebar now includes a description of the effect, along

with the element name.
• In the properties sidebar, a new Slide Background panel lets you quickly

change the format, orientation and background image of a slide.

LibreOffice 5.2 Released: What's New, Changed

https://blog.documentfoundation.org/blog/category/press-releases/
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Security has been beefed up a bit now, and now requires two passwords, your
Google Drive password plus a LibreOffice Master Password that you create the
first time you use the feature.

I liked the earlier new feature
that made a drop-down of the
Save toolbar button and
included Save As.. and Save
Remote File… Now they have
added another choice: Save As
Template…, so I have one less
reason to have to go through the
menu.

In Calc, new functions have been added. I don’t use too many functions so I’m
not too familiar with much more than addition or multiplication. However, the
improvement is in the tooltip, which explains a bit about the function you are
using.

In many programs, the status bar at the bottom of the window shows loads of
information. LibreOffice is no different. As a matter of fact, they have improved
the status bar information in Calc because now you can set it to show more than
one function. The lower right of the status bar has usually shown the sum of a
series of numbers or maybe it’s average. Right-clicking on that status bar location
gives you a menu where you can choose which functions you want to see.

In the image below, I have average, count and sum selected. So for my series of
numbers highlighted at left, the average is 56.00, there are 25 numbers, and their
sum is 1,400.00.

This spreadsheet is a list of sponsors for an event and how much money they
donated, and of course, at my house, the currency is US Dollars. However, there
are many more currencies in the world. If you are customizing your spreadsheet,
and are formatting the currency, LibreOffice now includes a drop-down to let you
choose the currency you need. You can place it in the formatting toolbar, by

adding the currency
button to your toolbar.
If you have to work
with several units of
currency, this feature
will help you get it
formatted faster.

The border function
has a new addition as
well. You can choose
to remove the
borders from the cells

LibreOffice 5.2 Released: What's New, Changed
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you highlight, but if you check the “Remove adjacent borders” check box,
LibreOffice will remove them as well.

Here’s the difference:

Impress has some new additions to its sidebar as well. Many of the effects can
be configured directly in the sidebar, and even some menu items open in the
sidebar rather than in a separate window.

Just to review, the sidebar is on the right side of your window (in each LO
program). It can be opened or closed. Many of the things you do to whatever

project you are creating can be done from the sidebar, and it changes according
to the item you have selected. For example, in Impress, the Properties section of
the sidebar displays the standard layout designs and formatting for a slide
(Orientation, Background and Master Slide), shown below at left. If you design a
slide and add text, the Properties sidebar changes to the text formatting tools
(Font, Size, Alignment and so on), shown below at right.

The icons at the right side designate the sections of the sidebar. From top to
bottom, Properties (the wrench), Slide Transition, Custom Animation, Master
Pages, Styles and Formatting, Gallery and Navigator. The drop menu above the
Properties button is the Sidebar Settings menu, where you can also designate
which menus you want on the sidebar, close the sidebar or even undock it from
the main window.

LibreOffice has had some wonderful additions, and from the release notes, they
have improved several items “under the hood” as well, including a revamped
Find and Replace window, more languages and a new template manager.

Hopefully, you will find that many items help you do more efficient work.

LibreOffice 5.2 Released: What's New, Changed

http://www.pclosusers.com/services-signup.php
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Screenshot ShowcaseScreenshot Showcase

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

Posted by meemaw, on August 3, 2016, running Xfce.

http://www.pclinuxos.com/?page_id=10
http://pclinuxos.com/?page_id=188
http://www.linuxquestions.org
http://www.opensource.org/
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by Peter Kelly (critter)

Most modern computer applications, such as word processors and graphic
design programs, have some method of allowing the user to undo actions that
are no longer required for some reason. Usually though, when you quit the
application, that capability is lost. Unless you made a backup, the old version is
gone forever.

Programmers realized a long time ago that this was an unsatisfactory situation
and decided to do something about it. The result was known as a version control
system and many of these systems soon appeared with varying abilities,
complexities and the inevitable disadvantages of one solution compared to
another.

For most of us who are not developers that are working concurrently on software
projects with many other developers, these systems are complex beasts that
require more effort from the user than is saved.

Git

One system though is different, and it is called Git. Git has an excellent pedigree,
along with some definite advantages:

* It was developed by Linus Torvalds to help control the development of the Linux
kernel.

* It is extremely stable as it has been around for a long time, since 2005, which is,
in fact, longer even than the PCLinuxOS magazine.

* It is powerful, but can be used by people with modest requirements, and by
mastering only a few of the many available commands.

* It does not require a client/server setup to operate.

* It is suitable for use by individuals in almost any type of project, not just coders.

* Although originally written for the Linux community, Git is available for use under
most popular operating systems including Mac, Windows and Solaris.

So what is Git? It is described as a ‘distributed revision control system,’ but don’t
let that put you off. That description says what Git is capable of, not what it can
be used for. Raw Git is a command line utility, but due to its wide adoption (it is
now the most popular revision control system out there), there are graphical front
ends to sweeten your life and to save your sanity.

Is Git for me?

Although designed to be used by many users on a project, a single user can
benefit from the system just as well. I do a lot of my work on my main computer,
and then continue to work on things from my laptop. The laptop is able to connect
to the main computer over the network, but even a single laptop or desktop
computer can utilize the benefits of Git.

How it will be useful to you depends on what you do, but let me give a simple
example.

You have a large collection of music files ripped from a collection of CDs with the
tracks from each CD in its own folder. Some of the CDs were compilations, and
you would like the tracks to be reordered by artist. If your collection consists of
thousands of tracks, then this is quite some task. If you later decide that the
original order was better, then unless you made a backup and now have two
collections, then you face another massive task. However, if you first create a Git
repository, which requires just three simple commands, then to switch between
the two sort orders is just another couple of simple commands. This is also pretty
quick, as the actual music data does not have to be re-written, only the change of
location is recorded. Also, once the repository is built, if you happen to lose a file
then recovering it from the repository is another simple task.

Using Git

Git was designed as a command line utility, but there are now several graphical
applications available. The graphical ‘front ends’ are great to help you visualize
the progress of your project, and to show what changes you have made. We can
utilize them to control our projects, but the real power of Git is on the command
line. So, I’ll show both.

Git: The Ultimate Undo Button
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There are an awful lot of commands and options in Git, but for the purpose of
controlling a project and taking periodic snapshots to which you can revert at any
time, we need very few.

In this demonstration project, I will create a Git repository, add some project files
to it and take a snapshot of the project at that initial stage (in Git-talk these
snapshots are known as commits, because you are committing your latest work
to the current state of the project). In the next stage I will add some more files,
modify some others and delete some of the original files and then take another
snapshot. Finally I will revert back to the initial snapshot which will also reinstate
the files that were deleted from the hard drive (yes, the files were actually deleted
but Git can reconstruct the files from the data it recorded in the repository). To do
all of this, I need to use only the commands:

init, add, commit, rm and revert.

During the explanation of the demo project, I shall use a handful of other
commands that output useful information to help with running the repository. They
should help to clarify exactly what is being done and why, but they are not
absolutely necessary. There a few other commands that I occasionally use, but
this is enough for most single user work, and it is only a tiny fraction of what is
available.

Getting started

Git is not installed by default in PCLinuxOS, but is available from the repositories.
Start up synaptic, reload, mark all upgrades and apply to get your system into a
fully upgraded state. Next, scroll down to git, mark it for installation, and apply.
This will pull in some other files that Git depends on. Just accept them. You now
have Git installed. Before you use Git for the first time, you need to supply a little
information. This is not a simple pleasantry, but a way of telling Git who has done
what. Git needs your name and your email address, but as we are not
collaborating with others, we can make these up as we wish. I entered the
commands:

git config --global user.name “pete”
git config --global user.email “pete@connaught”

The ‘connaught’ in the e-mail address is actually the host-name I gave to this
computer. Git is now ready for use.

To demonstrate the use of Git, I am going to create a simple web page with a
couple of other pages we can link to. It does not have be a web page. It can be
any type of document or set of documents that get changed from time to time. It

could even be programming code! You also do not need to understand about web
pages and HTML to follow along.

It is not difficult to use Git, but it is slightly different to most other applications. The
screenshot shows the output of the few commands used in the demo, which does
look rather overwhelming. But, if you follow along with the command line
instructions, then it should become clear.

Don’t worry. Git does almost all of that work for you.

The first thing we need to do is to create a directory to hold the files of our
project, which will be called ‘sunshine_island,’ and then to switch to that directory.
To do this, open a terminal and move to where you would like to store the project,
then enter these two commands:

mkdir sunshine_island
cd sunshine_island

We will now be in the new projects directory, which is referred to as the ‘working
directory.’ It is completely empty, so we need to tell Git that this is a ‘Git
repository,’ and set things up so that files in this directory are tracked by Git. The
command to set things up is the command git init

git init
Initialized empty Git repository in
/home/pete/sunshine_island/.git/

Git: The Ultimate Undo Button
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This creates a hidden directory structure in the current directory called .git that
contains all of the information required by Git to monitor the files that you create,
change or delete in this project. This directory is referred to as the ‘Git directory.’
You can explore this directory, but don’t change anything, at least until you decide
that you know what you are doing. Next, we need to add some files for Git to
track.

First though, a little bit of theory.

The Git repository is currently just a blank template. When we add files to the
working directory, Git needs to be told which of those files to track and which to
ignore. To tell Git to ignore a file or file type, create a file named .gitignore and list
them there. For example, some editors make a backup file with the name of the
file beginning with a tilde ‘~myfile.txt’. If you add ~* to this file, then all files of that
type will be totally ignored by Git.

Git uses the add command to place references to files in a holding or staging
area, where they sit until we are ready to ‘commit’ them to the repository.

When a file is committed for the first time, all of the data in the file is is added to
the repository with a reference key. The key is a unique string of 40 hexadecimal
characters, known as an SHA-1 checksum, which is used not for security
reasons, but for its uniqueness. Unlike file names, an SHA-1 key is unlikely to be
repeated during the life of this universe, so Git knows exactly which data is to be
referenced. We don’t need to know too much about all this though to use Git.

If a file that Git has been told to track is changed in any way, then Git knows
about it and can tell you. If you then ‘add’ the file to the staging area, only the
data that has changed is recorded. Once the changed files have been
‘committed’ to the repository, those data changes are added to the Git database
and referenced with a new checksum. From this database, Git is able to
reconstruct any set of files to any previously committed state - as we shall see.

The demo project

This the scenario.

Sunshine Island is a holiday brochure for a resort that you are setting up. You
don’t yet know what sort of visitors it might attract or what facilities might be
expected, so this is very much a ‘test the water’ sort of site which you may need
to change rapidly if potential visitors have different expectations. You may also
need to revert to the original specification if your interpretation proves to be
misguided. And for legal reasons, you should have a record of what you offered,
when and to whom.

Your first idea is for a resort that offers high class accommodation, a golf course,
cocktail lounge, sauna, pool – the full monty.

So far the web page description looks like this:

Main page - view of resort with links to attractions
Accommodation page - views and descriptions of rooms
Golf course page - views and descriptions of each hole
Cocktail lounge page - description of the bars facilities
Sauna page - Simple page outlining available services
Pool page - lots of pictures of people enjoying the pool
Tariffs page - Availability and prices for the islands features
Contact page - How to reserve, query, praise or complain

Within the Git enabled working directory, you can now create the necessary web
pages.

Initial feedback is not good. It suggests that the golf course would frustrate
visitors, as the monkeys love to steal golf balls. Also the sauna is a bad Idea,
since this is a tropical location and a hot sauna is not popular. The rest is not too
bad, but changes will have to be made. It is decided that the golf course be
removed and replaced with extensive tropical gardens, birds of paradise and
cute, tame animals. The sauna gets replaced with an air conditioned library
where residents can relax if the weather gets a little too hot for them.

The following changes are required to be made to the original idea.

Main page – edits to links to identify and point to new attractions
Golf course and Sauna pages are now obsolete and are to be removed
A new page highlighting the attractions of the tropical gardens is to be inserted.
A new page describing the new library is to be inserted.

Git: The Ultimate Undo Button
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Using Git with the project

The web page files are created and added to the working directory, together with
a folder named resources, which holds all the images, video clips and sound files
used by the web pages. The directory listing looks like this.

ls
accom.html golf.html lounge.html resources/ tariffs.html
contact.html index.html pool.html sauna.html

Git has a status command to show the current state of the repository

git status
On branch master

Initial commit

Untracked files:
(use "git add <file>..." to include in what will be committed)

accom.html
contact.html
golf.html
index.html
lounge.html
pool.html
resources/
sauna.html
tariffs.html

nothing added to commit but untracked files present (use "git add"
to track)

There is quite a bit of information here.

In the output is a list of all the files Git knows about and has not been told to
ignore. All our files are listed as untracked and appear in red. The resources
directory ends with a slash to show that it is indeed a directory. Git helpfully tells
us that we should use the command ‘git add’ to start tracking the files. As we
want Git to track all of these files, we can use the ‘*’ wild card (you could also use
a period - ‘git add .’), rather than name each file.

git add *

Now issue the status command again.

git status
On branch master

Initial commit

Changes to be committed:
(use "git rm --cached <file>..." to unstage)

new file: accom.html
new file: contact.html
new file: golf.html
new file: index.html
new file: lounge.html
new file: pool.html
new file: resources/golf.jpg
new file: resources/island-hotel.jpg
new file: resources/island.jpg
new file: resources/lounge.jpg
new file: resources/pool.jpg
new file: resources/sauna.jpg
new file: sauna.html
new file: tariffs.html

The status command now lists all of the files, including each of the files in the
resources directory, as new files, and shows them in green.

The comment ‘Initial commit’ tells us that there is nothing in the repository yet,
and any files that we commit will be the initial commit. These files have been
added to the staging area and we say that they are ‘staged.’ From here they can
be ‘unstaged,’ or they can be committed to the repository.

When we commit the files, we are prompted to specify a ‘commit message’ that
will describe the reasons for this commit. Git will not proceed without the
message. We can use the -m option on the command line to provide the
message, or git will open an editor showing what we will commit, and with the
cursor ready for us to type in the message. The default editor is vim, but this can
be changed in the git config file, just as we provided our e-mail address. I’m going
to use the -m option here.

git commit -m ‘Pre-launch web pages and images’

[master (root-commit) f81a260] Version 1.0.0 Pre-launch web pages
and images
14 files changed, 90 insertions(+)
create mode 100755 accom.html
create mode 100755 contact.html
create mode 100755 golf.html
create mode 100755 index.html
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create mode 100755 lounge.html
create mode 100755 pool.html
create mode 100755 resources/golf.jpg
create mode 100755 resources/hotel.jpg
create mode 100755 resources/island.jpg
create mode 100755 resources/lounge.jpg
create mode 100755 resources/pool.jpg
create mode 100755 resources/sauna.jpg
create mode 100755 sauna.html
create mode 100755 tariffs.html

git status

On branch master
nothing to commit, working directory clean

We now have a working repository, and we can at any time revert to this current
status.

Git also keeps a log which is displayed like this

git log

commit f81a260f3e2a5fe52d12e594f25881f84e5e6022
Author: pete <pete@connaught>
Date: Tue Jul 5 13:24:22 2016 +0100

Version 1.0.0 Pre-launch web pages and images

The SHA-1 reference is displayed in brown, and we have who did it, when and
why. This is repeated for each commit. The SHA-1 reference can be used to
access a particular snapshot but just the first few characters are enough, about 6
or 7 usually suffices, as you can see in the output from the commit command.

To achieve this working repository, we have used the three commands

git init
git add *
git commit -m 'Version 1.0.0 Pre-launch web pages and images'

That’s all. We had a few commands to set up Git initially, and we used the ‘status’
and ‘log’ commands to get some information, but those three commands were all
that was needed to create the repository. It really is that easy.

Changing the project

Our test audience were not too impressed with our proposed resort, so some
changes are needed.

* Two new files are created in the working directory: gardens.html and
library.html.

* The main page, index.html is edited to reflect the changes.

* Some new images need to be added to the resources folder.

* Two files need to be removed from the working directory and from Gits list of
tracked files.

To delete the files from the hard drive (don’t worry, git has this covered), and to
stop git tracking them, we use Gits ‘rm’ command – not the usual terminal ‘rm’
command – as we want git, not the usual operating system ‘rm’ command, to
keep control of what is happening in the ‘working directory’.

git rm golf.html sauna.html
rm 'golf.html'
rm 'sauna.html'

git status
On branch master
Changes to be committed:
(use "git reset HEAD <file>..." to unstage)

deleted: golf.html
deleted: sauna.html

We can commit this change and a new SHA-1 reference is created to reference
this change point in the project’s history. Note that nothing is actually done until
the commit command is issued.

git commit -m 'Version 1.0.1 golf and sauna pages removed'

[master 9638a4b] Version 1.0.1 golf and sauna pages removed
2 files changed, 20 deletions(-)
delete mode 100755 golf.html
delete mode 100755 sauna.html

git status
On branch master
Untracked files:
(use "git add <file>..." to include in what will be committed)
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gardens.html
library.html
resources/gardens.jpg
resources/library.jpg

nothing added to commit but untracked files present (use "git add"
to track)

The new files need to be added to the working directory, and then to Git’s list of
files to track. The files are separated by a single space.

git add gardens.html library.html resources/gardens.jpg resources/library.jpg

git status

On branch master
Changes to be committed:
(use "git reset HEAD <file>..." to unstage)

new file: gardens.html
new file: library.html
new file: resources/gardens.jpg
new file: resources/library.jpg

Four files are ready to be committed. The main web page file, index.html, also
needs to be modified before we commit.

git status
On branch master
Changes to be committed:
(use "git reset HEAD <file>..." to unstage)

new file: gardens.html
new file: library.html
new file: resources/gardens.jpg
new file: resources/library.jpg

Changes not staged for commit:
(use "git add <file>..." to update what will be committed)
(use "git checkout -- <file>..." to discard changes in working

directory)

modified: index.html

We now add this file to the staging area.

git add index.html
git status

On branch master
Changes to be committed:
(use "git reset HEAD <file>..." to unstage)

new file: gardens.html
modified: index.html
new file: library.html
new file: resources/gardens.jpg
new file: resources/library.jpg

We can see that now there are five files ready to be committed, so we perform
the commit.

git commit -m 'Version 1.1.0 - golf and sauna removed, gardens and
library added. Main page updated'

[master 33d5349] Version 1.1.0 - golf and sauna removed, gardens
and library added. Main page updated
5 files changed, 22 insertions(+), 2 deletions(-)
create mode 100755 gardens.html
create mode 100755 library.html
create mode 100755 resources/gardens.jpg
create mode 100755 resources/library.jpg

We now have three snapshots of our program, to which we can revert at any
time: this current version 1.1.0, the initial version 1.0.0, and an intermediate stage
we saved with just the golf and sauna pages removed. Even though some files
were deleted, they can be recovered. This sounds as though the git repository
could very soon grow to be excessively large, but in fact Git is very economical,
as it doesn’t work at the file level, but records only the changes in the files’ data.

Reverting to a previous edition

You are just beginning to update the tariffs page, having written a new massage
centre page to replace the library when you get a phone call. This is from Mr. Big,
the guy who writes the checks, and he is mad. “This is not what I signed up to” he
rants. “I liked the golf course. Put it back the way it was, or you’re fired!”

Oh dear, we deleted some of those files.

ls
accom.html gardens.html library.html pool.html tariffs.html
contact.html index.html lounge.html resources/

No golf or sauna files there.
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This is not a problem, we can easily jump back (or forward) in time with the help
of the SHA-1 key. From the Git log, we find that the original commit had a key
that began with f81a260. Git refers to your present position in the commit tree by
the name HEAD, so you just need to reset HEAD to where you want to go. To roll
back in one go through the range f81a260 to HEAD without being asked for a
message for each stage in the process, we can use the Git revert command with
the - -no-commit flag. Once we are in the desired place, we can commit this
status to Git.

git revert --no-commit f81a260..HEAD

git commit -m 'Reverted to initial commit'

[master f5210a8] Reverted to initial commit
5 files changed, 4 insertions(+), 4 deletions(-)
rename gardens.html => golf.html (79%)
delete mode 100755 resources/gardens.jpg
delete mode 100755 resources/library.jpg
rename library.html => sauna.html (82%)

Listing the files now in the working directory, we get this:

ls
accom.html golf.html lounge.html resources/ tariffs.html
contact.html index.html pool.html sauna.html

The golf and sauna files are back, so it looks as though you get to keep your job.
And, when he’s calmed down, you can re-introduce the changes you made with
just a couple of commands.

Disaster prevention

Git will never lose, misplace or corrupt any of the tracked files in your project, but
there is always the danger of some fool (?) overwriting or deleting the repository
or of hard drive failure. Git was designed to be a multi-repository system so that
any user could have their own copy of the entire repository. From any of these
copies, the entire project and all of its changes in history can be re-created. To
prevent a disaster, it is wise to create a copy somewhere else, in a different
directory, on a different partition or hard drive or on another computer, as I do with
my desktop/laptop set up.

The new location is going to be my home directory on my laptop, and from there I
can access my desktop computer. You simply need to be where you want the
repository to be created, and to be able to access the original repository. From

the home directory on the laptop, host-name ‘elysium,’ with the desktop mounted
as /mnt/connaught-home I enter:

git clone /mnt/connaught-home/pete/sunshine_island

Cloning into ‘sunshine_island’…
done.

cd sunshine_island
ls
resources/ contact.html index.html pool.html tariffs.html
accom.html golf.html lounge.html sauna.html

The cloning process is extremely quick, and I can now work with the project on
either machine. If the original repository was lost, damaged or destroyed, then I
could simply reverse the process.

Keeping things in sync

Obviously having two copies of the project and working on them independently
can result in a hopeless mix up with the elements of the project being in different
states. This is exactly what Git was designed to prevent, and it is exceedingly
good at its job. Git is capable of handling differences in thousands of repositories
all over the world over many years of project development, and it has the ability
to revert to any previously committed state. With our simple single user, two
location set up this really is just a walk in the park.

On my desktop computer ‘connaught,’ I add some image files to the resources
folder and then check the repository status.

git status
On branch master
Untracked files:
(use "git add <file>..." to include in what will be committed)

resources/gardens.jpg
resources/island2.png
resources/island_beach.jpeg
resources/library.jpg

nothing added to commit but untracked files present (use "git add"
to track)

I add these files to the repository, then checked the status again.

Git: The Ultimate Undo Button
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git add *

git status
On branch master
Changes to be committed:
(use "git reset HEAD <file>..." to unstage)

new file: resources/gardens.jpg
new file: resources/island2.png
new file: resources/island_beach.jpeg
new file: resources/library.jpg

Happy with that, I decide to make a commit. I’ll incorporate these files into the
source code of the HTML pages later.

git commit -m 'added some images to the resources folder'

[master f5210a8] added some images to the resources folder
4 files changed, 0 insertions(+), 0 deletions(-)
create mode 100644 resources/gardens.jpg
create mode 100644 resources/island2.png
create mode 100644 resources/island_beach.jpeg
create mode 100644 resources/library.jpg

The Git log shows this new entry (plus the others):

git log
commit f5210a8c70bb35b386c10c470fafff1ebbb23246
Author: pete <pete@connaught>
Date: Tue Jul 5 13:50:42 2016 +0100

added some images to the resources folder

Later, I decide that I will use my laptop computer ‘elysium’ to incorporate the
images into the source code of the HTML files. The repository on the laptop was
‘cloned’ from the one on the desktop, so the repository refers to the desktop as
‘origin.’ This is the default. To bring in any changes from the desktop to the
laptop, I can use the pull command.

git pull origin

remote: Counting objects: 16, done.
remote: Compressing objects: 100% (16/16), done.
remote: Total 16 (delta 5), reused 0 (delta 0)
Unpacking objects: 100% (16/16), done.
From /mnt/connaught-home/pete/sunshine_island

f81a260..f5210a8 master -> origin/master
Updating f81a260..f5210a8

Fast-forward
resources/gardens.jpg | Bin 0 -> 29671 bytes
resources/island2.png | Bin 0 -> 88053 bytes
resources/island_beach.jpeg | Bin 0 -> 6790 bytes
resources/library.jpg | Bin 0 -> 280028 bytes
4 files changed, 0 insertions(+), 0 deletions(-)
create mode 100644 resources/gardens.jpg
create mode 100644 resources/island2.png
create mode 100644 resources/island_beach.jpeg
create mode 100644 resources/library.jpg

The laptop repository is now at exactly the same state as the desktop.

Local and remote repositories

To transfer information between repositories, Git has three main commands:
fetch, pull and push. Fetch gets the changes from a remote repository. Pull, as
we have seen, gets the changes and merges them into the local repository, while
push is simply the converse of pull.

The Git ‘remote’ command will list all known remote repositories, and adding the
-v option will give a more verbose output. The cloned repository on the laptop is
automatically assigned the name ‘origin’ to its ancestor, but back on connaught,
the desktop, we would have to supply the full URL of the laptop to perform the
same operation. This is not very convenient, and can lead to errors. So, Git
allows us to define aliases for remote locations with the ‘remote add’ command.

git remote add elysium /mnt/elysium-home/pete/sunshine_island

git remote
elysium

git remote -v
elysium /mnt/elysium-home/pete/sunshine_island (fetch)
elysium /mnt/elysium-home/pete/sunshine_island (push)

In our setup, the same URL is used for transfers in both directions. Now we can
use the same ‘git pull’ command, as we did on the laptop substituting elysium for
connaught.

Having done some work on the laptop, I now want to update the desktop to
continue working, so I pull in the changes. However, this time I need to specify
master as the branch to pull (we will cover branches soon).

git pull elysium master
From /mnt/elysium-home/pete/sunshine_island

Git: The Ultimate Undo Button
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* branch master -> FETCH_HEAD
Updating f5210a8..bdf2a88
Fast-forward
index.html | 3 +++
1 file changed, 3 insertions(+)

git gui – a graphical interface

There are many graphical interfaces available for Git, but the one I am going to
demonstrate here is git gui (that’s two words), which is part of the git installation.
There are more available for installation in the PCLinuxOS repositories, such as
QGit and Giggle. The Eclipse IDE (Integrated development Environment) also
supports Git as a separate ‘perspective.’ Eclipse is also available from the
PCLinuxOS repositories.

Actually git gui is a tool for making commits, branches and merges, and has
access to another tool called gitk, which is a graphical history viewer, but we can
do almost everything we need with these tools.

To launch the application, type git gui in a terminal, or in the alt+F2 run dialog, or
you can add a shortcut to your desktops main menu. This is not done by default.

The options are pretty much self explanatory, and as I have used this before, my
sunshine_island repository is offered in the recent repositories section. Selecting
sunshine_island, I get this not very informative window.

A few minutes exploring the menu options should give you a good idea of what
this tool can do, and you will recognize many of the options from our command
line terminal sessions.
In the previous sessions of our demo project, you were instructed by Mr. Big to
revert to the original ideas, which you did, and subsequently added some images.
In your heart of hearts, you know that Mr. Big will eventually come around to your
way of thinking, so you decide to work on the alternative version alongside the
current one. To do this, you will create a branch.

You can think of a branch as a fork in the road of your projects direction. Just like
a fork in a real road, each branch leads to a different destination, although they
may meet up again at some point in the future.

Git: The Ultimate Undo Button
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In a graphical environment, it is much easier to visualize the repository and the
concept of branches, which is why I delayed explaining branches until now. From
the menu, select Repository > visualize All Branch History. You will get something
like this.

This page is a lot more interesting. In the top left window, we can see both the
local and remote repositories and all of the commit history. Marked in green are
the current branches of each repository, which at the moment is master, as this is
the default created by Git, and we haven’t yet created any others. Clicking on any
of the lines in the history changes the contents of the other panels to reflect that
commit. Above the bottom right panel are two radio buttons, Patch and Tree.
Patch shows the changes at this point in the history, and Tree shows the files that
would be found in the working directory at that point. Clicking on one of the files
will show the contents of that file on the left (images are not rendered as images
here, but in QGit they are which is a nice feature). Click on the line that has the
commit message beginning with ‘Version 1.1.0...’ This is the snapshot that we
want to start with in our new branch. Copy or make a note of the first 6 or 7
characters of the SHA-1 ID. Close this window and in git gui select branch >
create.

In the dialog that appears, give the new branch a name, select ‘Revision
Expression’ and enter the SHA-1 reference, then deselect Checkout After
Creation. I would normally leave this box checked, but for this demo I will
uncheck it.

Full Monty ...

Everything you might want or need –
plus the kitchen sink!

Git: The Ultimate Undo Button
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Click create. Nothing seems to have changed but bring up the ‘Visualize all
Branch History’ window, and you will see the new branch at the chosen revision
point in the local repository.

Close this window, and from the git gui menu, select branch > checkout, select
the version2 branch, click checkout, and then re-open the visualization window.

Branch version2 is now in bold indicating that it is now the current branch, and it
is at the revision position that we chose. The remote repository remains at branch
master. It is important to realize that the checkout command will also change the
contents of the working directory as required.

We can now do some changes, and they will only be visible in the branch
version2 while the master branch that is currently in use on the distributed web
site will not change.

Reload the new images into the resources directory and edit the main page to
show them. In the git gui window, press F5 to update the display and these
changes will show as unstaged changes.

Git: The Ultimate Undo Button
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Highlight the changed files and select Commit > Stage Changed Files to stage
them for committing, and they will move into the lower left pane.

Type a suitable commit message in the box lower right, and select Commit >
Commit to perform the commit action.

In the visualisation window, we can now clearly see the effects of our branching
and commit.

We can carry on working on this branch, but if we need to change things on the
currently published web site, we can easily check out the master branch. We can
also pull in these changes in the remote repository, or we can push them to the
remote from the git gui menu option remote > push.

At some stage, you may want to merge the two branches together to incorporate
changes in each. You can easily do this with the git gui merge menu option.

In the dialog that appears, your current branch is already selected, and you have
only to select the branch that you want to merge in. There is also a very helpful
Visualize button that allows you to see the results before actually performing the
merge.

Git: The Ultimate Undo Button
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In our demonstration project, there is little to be gained from merging the
branches, but we will do it anyway.

Uh-oh! That failed, but the situation is not as bad as it first seems. As the warning
tell us, there is a conflict in index.html, and we must manually resolve this conflict,
and then commit the adjusted file to complete the merge. Git has a tool called git
mergetool, which uses one of several tools similar to the Linux diff command to
show the conflicts. My personal favourite of these is meld, which is in the
PCLinuxOS repositories. You can add this to your .gitconfig file by adding or
changing these two lines:

merge.tool=meld
diff.tool=meld

From the Branch menu, checkout the master branch to make it the current
branch, then issuing the command:

git mergetool

Displays this window, or something similar if you don’t use meld.

This clearly shows the conflicts, and you can edit the centre panel to modify what
will be put into to the merge, and then complete the merge by doing a commit.

Merging:
index.html

Normal merge conflict for 'index.html':
{local}: modified file
{remote}: modified file

After performing the final commit, the history looks like this:

Git: The Ultimate Undo Button
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Git is a very powerful tool and I have covered only the very basics of what it can
do, but for many people this is enough. Once you get to be familiar with the
basics and have used Git a couple of times, it is also easy to work with. This
article was created using git, which helped enormously with getting the demo
project synchronized with the images and terminal outputs.

There are many ways that I could have performed the operations used in the
demonstration and Git purists will probably pour scorn on me for my minimalist
approach, but it works and so this is how I do it. The steps outlined here are not
suitable for a multi-user collaboration, as no consideration is given to other
persons contributions, but for a single user, they work just fine.

If you want to learn more then the documentation on the git website is pretty good
and includes a link to a book, ‘Pro Git’ written by Scott Chacon and Ben Straub. It
is published under the creative commons license, can be read online and is very
comprehensive, but is also suitable for beginners.

The PCLinuxOS Magazine
Special Editions!

Get Your Free Copies Today!
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by joechimp

10 years. A sideways glance in the Universe. A mere
blink of a cosmic eye. A Day in the Life, of many
things. However, here on the Planet Earth, it is a
significant passage of time.

Congratulations and Happy Anniversary, PCLinuxOS
Magazine. Also to Paul Arnote and to Meemaw,
ms_meme, YouCanToo and to all of you that create
the magazine each month (don’t know all the
names, sorry, but I know there are more), and those
from the past as well. Congratulations to Bill
Reynolds, whom, without his creation, none of this
would be possible. Also to all who have left their
footprint on the surface of this fine magazine and
excellent OS.

If I may indulge for a moment … a Chimp’s
remembrances.

I did not come along at the beginning. It was a little
later in the game. I just celebrated my seventh full
year of being with PCLinuxOS.

In the beginning, I was helped by some of the
greats. You all know who you are. I don’t want to

leave anyone out. I will mention a few names
though. Our late friend Joble was so helpful to me
when I first arrived. Neal, my dear Friend Neal, I
miss him a lot. I do hope his life is peaceful.
“Johnboy," do you remember him? Do any of you
know who he is now? He helped me so much with
my first attempt at creating a live USB. Then there
was O-P. He used to yell at me for putting all caps in
the titles of my threads. However, when it came to
helping me with issues that I might have, he was
always very helpful in my newbyship. Then we have
the Top Gun … Tex. Mr. Bill Reynolds. Taking the
time to help out a chimp. There are not many places
you could find that. LOL. He was and still is great.
Thank you, Sir, for changing my life.

There were so many others, those who were so
patient with me. I am sorry if I left anyone out. That
is not my intention. No one looked down on me. I
knew then I had found a home.

I made some good friends, too. My good friend
Rudge. He and I have a great bond for two guys
who never met in person. I think he is a great guy.
He makes me laugh a lot, and has always been
there if I wanted to share something. We came along
about the same time, and have many things in
common. I know that he is there for me, and he
knows I am there for him. To me that is Friendship.
He is also my fellow Bandmate in the now infamous
PCLinuxOS Band. He is a world renowned drummer.
He is also a lucky guy being married to a Super
Model. It is an honor to call him my friend.

Then there is Archie. He is a great guy too. He has a
way of peace in his heart that makes me appreciate
his friendship very much. I remember so many times
in my early days here, that he was helpful in more
ways than I can describe. His steady approach to life
helped me at times, when I needed it most. Archie, a

man I appreciate, not just for that, but for what he is
as a human being. Thank you my friend.

David (YCT) and Alie (present_arms), thank you for
your generosity of time. Always there, for not only
me, but for anyone seeking help. Really good guys.
Friends worth having. Thank you both.

I wanted to mention the people I have the most
interaction with. The rest of you that I call friend,
know who you are. Please don’t feel that I don’t care
about you as friends. You all mean a lot. I thank you.

10,000+ posts … a “Super Villain.” I can hardly
believe it. I started out as a strange visitor from
another planet … able to leap … oh, yeah, wait, that
was someone else.

THE MAGAZINE: 10th Anniversary. Amazing.

I remember in the early days, discovering the
Magazine. Wow, a wealth of information. In depth
discussions of many subjects. All that you needed to
know, to learn about a certain program or solve a
problem. Lots of humor as well. I liked it right off.

There was that one dark period. One issue that fell
through the cracks. Archie decided to do an expose,
interview of yours truly. It’s called filler. LOL. No, in
all seriousness, I was honored to be included. It
really made me feel like I belonged here. Archie did
a great job with the little I gave to him to work with.
Lots of fun.

DOWNLOAD

Mate Desktop

A Day In The Life: An Anthology Of Sorts
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I remember fondly another issue that featured the
PCLinuxOS band. That’s right. To all you new
people, we really did have an international/
interstellar band. There was a great write up on us,
and I think a link to our first song was included.
Read more here. All the members of the band are
included in the magazine article. Rudge,
BubbaBlues (Great guy, miss him in the forum),
HorusFalcon (another good friend and a wealth of
information), Longtom (don’t know where he went),
ms_meme (ah, sweet girl she is), and ME! Great
bunch of good people. Yes, I was part of the band.
Lead Vocals.

ms_meme, a great lady and lyricist to the infamous
Band. She is the sweetest thing since Tupelo Honey.
Her contributions to the magazine are endless. Her
humor and musical ability are sprinkled throughout
the history of the magazine. She is talented beyond
words. Her prose speaks volumes. I/We hold her
dear to our hearts.

The magazine offers great recipes, if you like to
cook. Currently, David (YouCanToo) has a monthly
delicious recipe each issue. Sometimes two. Mouth
watering. I have gotten to know David well in the last
year or so. I admire his ingenuity and his

selflessness. He does so much for PCLinuxOS.
Many people are unaware of this. He is also my
friend. Plus, he is creator of the CHIMPBOX. The
best little computer that money can buy. The
magazine, the forum and the OS are lucky to have
him.

The Magazine offered and offers so much. I think it
is reflects in large part, the popularity of our Distro.
The willingness of people to work hard to prepare
the magazine and those that contribute the content.

Someone new to PCLinuxOS would profit greatly
from starting with the first issue and working their
way to the current one. They would get a sense of
not only the evolution of PCLinuxOS, but learn so
many things about what programs are available to
them.

I am honored to contribute to the 10th Anniversary of
the PCLinuxOS Magazine. I hope I am around when
the next 10 rolls around.

Thank you, Paul. The Magazine is and has been in
good hands since you took over. Hope you continue
for years to come.

Congratulations and Happy Anniversary, PCLinuxOS
Magazine. Also to Paul Arnote and to MeeMaw ,
ms_meme, YouCanToo. Paul runs the ship, with

Meemaw right by his side, YCT doing the HTML plus
writing and recipes. Ms-meme contributes with her
various artistic contributions. What a great job they
do, and to all of you that create the magazine each
month (don’t know all the names, sorry, but I know
there are more), and those from the past as well.

Congratulations to Bill Reynolds, whom, without his
creation , none of this would be possible. Also to all
who have left their footprint on the surface of this
fine Magazine and excellent OS

David (YCT) and Alie (present_arms), thank you for
your generosity of time. Always there, for not only
me, but for anyone seeking help. Really good guys.
Friends worth having. Thank you both.

Uncle V, my friend, is a great guy. Might be as crazy
as me.

Wanted to mention the people I have the most
interaction with. The rest of you that I call friend,
know who you are. Please don’t feel that I don’t care
about you as friends. You all mean a lot. I thank you.

May all of you … Live Long and Prosper!

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!

The PCLinuxOS Magazine

Created with Scribus

A Day In The Life: An Anthology Of Sorts

http://pclosmag.com/htdig
http://www.scribus.net


PCLinuxOS Magazine Page 43

As told to YouCanToo

What is your name/username?
Kurt Stokke/bloomer

How old are you?
67

Are you married, single?
Married for 40 years

How about Kids, Grandkids?
We have one son, 34 yrs. old, and a granddaughter,
4 yrs. old

Do you have pets, what is your favorite?
We have an energetic, bouncing 3 yr. old NW Farm
Terrier

Are you retired, still working and if working, what
do you do?
Retired

Where do you call home? What is it like? IE:
weather, scenery:
We live in Port Angeles on the beautiful Olympic
Peninsula in Washington State just outside Olympic
Nat. Park. There are the Olympic Mountains, ocean,
and rainforest. The weather is temperate, with mild
winters.

Where did you go to school and what is your
education level?
Went to Roosevelt HS in Seattle and Peninsula
College in Port Angeles

What kind of things you like doing? hobbies,
travel, fishing, camping?
We have camped extensively here, and traveled to

Belize, CA, and almost moved there. My hobbies are
fishing, reading, fiddling with different Linux distros.
I'm very interested in astrobiology, cosmology,
astronomy, theoretical physics, and space
exploration.

Why and when did you start using Linux?
I started using Linux in 1998 out of frustration with
crashes, etc, and the proprietary nature of Windows,
and lack of ability to configure things the way I
wanted to. I haven't used Windows since Win98,
other than to help my wife with her laptop, which has
been updated to Windows 10. She's still resisting
installing PCLinuxOS, even though she uses
PCLinuxOS on my desktop whenever there's
something really important she needs to work on,
and needs to use a more stable platform.

PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by YouCanToo, featuring PCLinuxOS
forum member. This column will allow "the rest of us" to
get to know our forum family members better, and will
give those featured an opportunity to share their
PCLinuxOS story with the rest of the world.

If you would like to be featured in PCLinuxOS Family
Member Spotlight, please send a private message to
youcantoo, parnote or Meemaw in the PCLinuxOS forum
expressing your interest.

Visit.
Contribute.

Build.

The PCLinuxOS
Knowledge Base

It Belongs To YOU!

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

Want To Help?
Would you like to help with the PCLinuxOS
Magazine? Opportunities abound. So get
involved!

You can write articles, help edit articles, serve
as a "technical advisor" to insure articles are
correct, create artwork, or help with the
magazine's layout.

Join us on our Google Group mailing list.

PCLinuxOS Family Member Spotlight: bloomer

http://pclinuxoshelp.com/index.php/Main_Page
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http://groups.google.com/group/pclinuxos-magazine
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I never knew what Linux was all about
I never knew what I was missing out
All I know is that I fell in love with it
And if all my dreams come true
I'll be spending more time using it

Every day's a new day how I love to compute
With each day comes a new way that I spend with Root
Every day I'm in the console I feel such bliss
And if all my dreams come true
I will always be a doing this

I love Linux more today than yesterday
But not as much as tomorrow
I love it more today than yesterday
But no not as much as tomorrow

With my PCLinuxOS friends I just love to play
We all may be mad but we're here to stay
Thanks to Texstar our ties grow ever stronger
And if all our dreams come true
We'll be using it longer and longer

We love Linux more today than yesterday
But not as much as tomorrow
We love it more today than yesterday
But not half as much as tomorrowMP3 OGG

ms_meme's Nook: I Love Linux More Today

http://pclosmag.com/html/Issues/201609/files/ilovelinuxmoretodaythanyesterday.mp3
http://pclosmag.com/html/Issues/201609/files/ilovelinuxmoretodaythanyesterday.ogg
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by Meemaw

I thought we’d make some fancy text for the
magazine’s 10th birthday. Open your GIMP and
create a new project at least 800 x 600 px. Using the
text tool, enter your text and edit it to your liking (font
and size). Now click on Layer > Text to path, which
will outline your text with a path. However, we can’t
see the path yet. Go to the paths tab, choose the
path and make it visible by clicking the eye next to it.

Click on the path tool in the toolbox and click on the
text (within the outline somewhere). You now will see
nodes on your path, and you can move nodes or
part of the path to alter your text.

When you have your nodes edited, add a
transparent layer above your text. With the path tool
still selected, click on the new layer. Below your path
tool (on the bottom left of your window, probably) are
the settings for the path tool. Click on Stroke path,
and in the window that appears, change the line
width to 8 px, then click Stroke.

You have your text on a new layer now, so you can
go back to the paths tab and “turn off” the visibility of
the path. Save your work.

Making sure your new layer is selected, click on your
ellipse select tool, and draw a small ellipse over one
of the places you edited in your text. Click on Filters
> Distorts > Whirl & Pinch, and set the Whirl to
about 300. You can see that the path inside your

ellipse with twist around into a curly shape. You can
do that to each of the paths that you created simply
by grabbing the ellipse (don’t change tools) and
moving it to the new spot, then choosing Filters >
Repeat Whirl & Pinch, which is now at the top of
the menu.

When you are finished changing your text, choose
Filters > Alpha to Logo > Glossy. From the window
that appears, choose the two gradients you want to
use, then apply. You might have to experiment to get
the look that you want, but remember, you can go to
Edit > Undo, then start over on your gradients as
many times as it takes to get what you want.

To finish, one option is to click on the layer
Background 1 and put a gradient on it with the Blend
tool. I used a background to foreground gradient.
Now choose Filters > Artistic > Clothify or Filters
> Artistic > Apply Canvas. Color it in a manner that
will blend with your text. One way to do that is to

GIMP Tutorial: Fancy Text
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choose Colors > Colorize. The Hue slider will
change the color however you want, then move the
Lightness and Saturation sliders until it looks good to
you.

Screenshot ShowcaseScreenshot Showcase

Posted by Mr_Cranky_Pants_YouCanToo, on August 2, 2016, running KDE.

GIMP Tutorial: Fancy Text

http://chimpbox.us
http://www.linuxfoundation.org/
http://www.linuxforum.com
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Have you ever wanted bacon and candy but you just
couldn't make up your mind? Well, now you can
have both! Pig Candy is a great treat that will
impress your friends and make your neighbors
jealous.

Ingredients

12 oz thick cut bacon. About 11-12 pieces.
1/3 cup brown sugar.
1/4 cup pure Grade A maple syrup.
1/4 tsp cayenne pepper.

Directions

• Preheat the oven to 350 degrees F. In a small
bowl, mix together the brown sugar, and cayenne
powder.

• Line a baking sheet with a sheet of tinfoil. Place a
baking or cooling rack atop the lined baking sheet
and lay the bacon side-by-side.

• Sprinkle half of the brown sugar mixture onto the
bacon, pressing it into the bacon to be sure it
adheres.

• Bake for 8 minutes, or until very lightly brown.
Take the bacon out of the oven and brush the top

side of the bacon with maple syrup. Return to the
oven to bake for an additional 2-3 minutes. After the
3 minute mark, flip the bacon over, and sprinkle the
bacon with the remaining brown sugar mixture.
Return to the oven and bake for an additional 10
minutes. Brush the top side with maple syrup and
bake for an additional 2-3 minutes.

• Allow the bacon to reach room temperature or until
it's cool enough to handle and then transfer the
bacon to a sheet of parchment or a plate.
Store any leftovers in refrigerator.

PCLinuxOS Bonus Recipe

Pig Candy
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by Patrick G Horneker

First, my congratulations on the tenth
anniversary of PCLinuxOS Magazine. I
had the pleasure of writing what I did for
this publication.

Speaking of anniversaries, this year
marks the twentieth anniversary of my
website which started out as an OS/2
support page on GeoCities (how many of you
remember that hosting site before Yahoo! took
over?), and evolved to a website now serving
multiple Linux distributions.

Also, this year marks the twenty-fifth anniversary
of the Linux kernel (established in 1991).

The fact that PCLinuxOS was built without corporate
support and without billionaires getting involved is
amazing. PCLinuxOS does well for those just
starting out in the world of Linux, but we still have a
long way to go as far as development goes.

No longer is Linux itself simply about replacing the
operating system on your laptop or desktop. Cloud
computing and virtualization are two of the latest
trends for Linux.

For those of you not familiar, cloud computing is the
use of networked machines accessible through the
Internet, where data is stored and applications are
developed and deployed making such applications
available to the end user, where all the end user has
to do is access the application through a web
browser.

Google Docs is an example of a cloud computing
application. The office suite that we use to produce

these articles was developed at Google and stored
on their servers. All we do is use a web browser to
access that application.

OpenShift is another platform where applications are
developed and deployed in programming languages
such as Java, PHP, and Python. You can install
OpenShift on a server as part of a private cloud, or
you can use Red Hat’s cloud
(http://www.openshift.com) to develop and test
applications, and sync those applications on your
local machine for offline development (and maybe
deployment on a private cloud running OpenShift).

SuSE Studio (http://www.susestudio.com) is another
cloud computing service that allows you to create

your own Linux distribution (based on
OpenSuSE or SuSE Linux Enterprise) and
distribute your product on a DVD (or a
flash drive), a virtual machine image for
QEMU or VirtualBox, or a cloud image for
Amazon Web Services.

Docker (http://www.docker.com) is another
technology developed for the deployment
of applications in virtual machines called
containers. The concept of containers can

be compared to shipping of merchandise in
containers that are loaded at a factory in some far
away place, then taken to a terminal for the
container to be loaded onto a ship bound for Prince
Rupert, at which the container is then loaded onto a
container train bound for Chicago. Then at Chicago,
the container is then loaded onto a truck for local
delivery.

A Docker container is intended for deployment of
self contained application running on an instance of
Linux (so far Fedora, Ubuntu, Debian and
OpenSuSE are supported), where the operating
system image and its application (and
dependencies) are stored on one image file.

The intent of Docker is to facilitate development and
distribution of Internet applications, independent of
the underlying operating system where the
application was developed. Docker uses
virtualization to execute containers.

Speaking of virtualization, we have QEMU,
VirtualBox, Xen and VMWare available for Linux.
Only VMWare is a commercial product. Hyper-V was
designed as a virtual machine for Windows, and
Parallels is a commercial product for Mac OS-X.

Installing and running PCLinuxOS on Parallels,

Patrick Horneker, from 2009

On Anniversaries ...
And The Future Of PCLinuxOS
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fortunately, will not void the Apple warranty, and is a
safe way to dual-boot between Mac OS-X and
PCLinuxOS. In fact, you can run both operating
systems at the same time on a Mac.

While I’m not as active on the PCLinuxOS forum as I
once was, I have not given up on PCLinuxOS. On
my laptop, it is running inside QEMU on the latest
version of Fedora (which should be version 24 by
the time you read this). I am deciding whether to
convert to dual booting between Fedora and
PCLinuxOS (an interesting American combination).

Which brings up the next topic: The future of
PCLinuxOS.

December 1998 was when I first started using Linux.
I obtained a AcerFrame 500 machine with a SCSI
hard drive and a single floppy drive. The machine
was running Novell Netware 3.x. I installed a CD-
ROM drive (and an ATAPI controller), and replaced
NetWare with Red Hat Linux 5.0.

This was a time when most people connected to the
Internet through a 56K modem and a phone line,
and data was backed up with a tape drive or on
floppies.

Fast forward to 2007. I was introduced to
PCLinuxOS when I purchased a magazine
containing a DVD-ROM that had the distribution. It
replaced the Mepis installation I was running at the
time. (Note: Mepis itself is no longer being
developed, but has continued on as Anti-X, and
even that has not been as successful.)

I have tried other distributions over the years, and
am now split between PCLinuxOS and Fedora, both
of which are great products, and both keep up to
date with what I consider to be essential software.

The fact that PCLinuxOS has dropped 32-bit support
altogether is an indication that 64-bit operating
systems are the future of computing. There are still
plenty of distributions that support 32-bit machines

(Pentium IV or earlier class), but then older
machines will never be able to effectively run a
modern Linux distribution and/or a modern desktop
such as KDE 5 (which is still under development for
PCLinuxOS).

So, dropping 32-bit support makes sense here.
Where 32-bit support is needed, say for running
Wine, there is a separate 32-bit libraries package in
the repository.

Also the decision to not include systemd was a risk
taken. (Some of you will disagree with me on this,
but that is just my opinion.)

Yes, systemd is a complex system of controlling your
Linux machine, but it is not that bad as it looks. In
fact, systemd actually makes easier work when it
comes to system administration.

Having said that, I would like to bring up another
question.

Is PCLinuxOS ready for the future of information
technology, especially when it comes to the
enterprise, cybersecurity, and cloud computing?

I’ll leave that for you the readers to decide.

In my opinion, PCLinuxOS is a great system for a
desktop replacement. As of this writing, DistroWatch
ranks PCLinuxOS as 15th, with Slackware just
below that at 16th (creeping up from 20th last
month), Fedora at 6th, CentOS at 7th, Manjaro at
5th, OpenSuSE at 4th, and Mint at the top of the list.

This is not the only thing of concern here. Microsoft
has included some Linux functionality in Windows
10, with a compatibility layer that allows some Linux
binaries to run on Windows, not unlike WINE that is
available in the repository. Also, the Bourne Again
Shell (or bash as we know it) has been ported to
Windows 10. Microsoft in exchange has provided
the Visual Studio Editor for Linux distributions.

All of this is thanks to Canonical and its recent
partnership with Microsoft. From what I have seen
going on with their flagship product lately, Canonical
is fast becoming another Microsoft.

So now, we also have Windows 10 to compete with.
Fortunately for us, PCLinuxOS does not
automatically delete any software without the user’s
permission.

Ease of use in PCLinuxOS is one thing, but keeping
PCLinuxOS safe and secure (just as Red Hat has
done with SELinux) is another. While SELinux
provides a second layer of security in the form of file
and resource labelling and auditing, there is nothing
like common sense and Internet safety to ensure
that security.

As for cloud computing, I would like to be able to run
Docker on PCLinuxOS. This would allow a database
server, Apache, and a Java application server all
running at the same time on PCLinuxOS, using
fewer resources, not to mention a few instances of a
few Linux distributions running inside those
containers.

If this is not possible, then we could come up with a
similar product (to add to the list of packages written
specifically for PCLinuxOS) that does something
similar to Docker.

Patrick Horneker was a contributor to The PCLinuxOS
Magazine after its relaunch in July, 2009. He wrote
several articles for the magazine back then, and accepted
an invitation to write an article for the magazine’s 10th
anniversary.

On Anniversaries ... And The Future Of PCLinuxOS
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It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

Posted by nymira, on August 2, 2016, running Mate.
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Created with Scribus
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by Dave Spagnol [DaveCS]
Reprinted with permission from his blog

[Note that in the examples that follow, all quotes,
single and double should be straight, even if
they appear to be left and right quotes.]

The Xfce4 desktop is known as a lightweight, fast,
functional desktop, yet it has many features. It has a
Desktop Settings Manager which calls a number of
applets, not as complex or as many the KDE
Settings Manager, but all that most people will ever
need. There are a number of Panel apps that can be
added. The Launcher is the most flexible I have
seen. It can appear as a single icon to launch one
program, or as an icon with a small arrow, which can
have a drop-down menu, and this is done simply by
adding more than one program to the Launcher. The
top launcher will be the main icon, and if you want
the program to re-appear in the drop down, just add
it again.

As you can see from the screenshot here, I have put
all parts of LibreOffice onto a single launcher.

There’s more. Unlike some desktop panel program
launchers, you are not totally tied to menu items.
When you add an item, it can be from your usual
startup menu, but you can also create it from scratch
if you know where to find the executable file, icon,
and you can use your own text in the name and the
description. Or you can create your own by
amending it from the standard entry.

What about GenMon?

With all this power you’d be amazed that Xfce4 runs
so smoothly. One panel applet it does lack, however,
is a CPU temperature monitor. So I am going to
design one using GenMon.

What I am about to write may not work for you, this
is about technique. You will need to install psensor,
available from Synaptic in PCLinuxOS. You may
also have to root around in a folder called
/sys/class/hwmon/ which is a “virtual folder” from
which you can read stuff about your computer’s
hardware monitoring.

GenMon is a panel applet that runs a shell script that
you write. The script must cause up to four lines to
be echoed (printed). The lines are in this format:

<txt>Text</txt>
<tool>Tooltip</tool>
<img>image.png</img>
<click>program</click>

Any of these can be variables, so that a number of
conditions can be measured, and choices made as
to the content of what is seen on the screen. The
image will be an icon, the click will be a program that
is run only where there is an icon to click on, the text
can be any text, and the tooltip can also be any text.

My computer’s processor is an Athlon FX4100. Its
hardware monitor returns only two numbers, some
return loads of them! The first is the temperature of
the core of the processor. The second is the power
being dissipated from the processor by its heatsink.
Open your file manager at
/sys/class/hwmon/hwmon0 and you may see this:

The virtual text file, temp1_input, contains the CPU
core temperature, in 1000ths of a degree Celsius.
You cannot open this file with Mousepad (Xfce’s
default text editor), but you can read its contents at
any given time. Open up a terminal and type in

cat /sys/class/hwmon/hwmon0/temp1_input

You will get a figure, probably in the 10,000s. Or
maybe you may have to look somewhere else for
this file. But I am assuming for now that this is the
right one. In order to capture that value into a
variable in a script file, your line would be like this:

temp1=`cat
/sys/class/hwmon/hwmon0/temp1_input`

XFCE4: Using the General Monitor (Genmon)
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Note that the reverse apostrophes cause the text
output from a command to be returned so that you
can allocate it to a variable, in this case, temp1. The
folder /sys/class/hwmon/hwmon1/ contains a similar
file called “power1_input”. If you type into your
terminal:

cat /sys/class/hwmon/hwmon1/power1_input

You will get a number in the 10,000,000s, indicating
the power dissipation of the heat from the CPU.
Many CPUs do not return this number, instead
returning a fan speed. You will find something,
somewhere in the hardware monitors folders which
might be useful. But for me, this is useful, so I will
add another line to my script file.

power1=`cat
/sys/class/hwmon/hwmon1/power1_input`

Now, the question is to manipulate those two
numbers so that they can show useful information
on your Genmon applet on your panel. If the “cat”
commands above do not return figures that may be
usable to you, you’ll need to find out more about
your hardware. The stuff is all there, somewhere!

I did come up with some multi-line stuff, which
manipulated the numbers, separating the division
and the remainder and putting a decimal point
between. What I wanted was 4 significant figures
with a decimal point included, mainly so that the
number would not change length, always consisting
of 5 characters, i.e., 5.030, 54.37, or 120.2. Here is
one way of going about it, dividing temp1 by 1000:

#First we divide by 1000, but this loses
any decimal points.
temp2=$(($temp1/1000))
#Now we get the remainder.
temp3=$(($temp1%1000))
#Now we have to add leading zeroes to the
remainder
temp4=$((1000+$temp3))
temp3=${temp4:1:3}
#And finally…
temp4=$temp2″.”$temp3

#and to 4 significant figures:
temp1={temp4:0:5}”°C”

It works, and works well, but I wanted to find
something tidier so I had a look around on the net to
see if there was a tidier way to do floating point
arithmetic. I chose awk rather than bc, because bc
does not use a leading zero on numbers below 1.

awk is actually a quick and dirty programming
language (you learn something new every day). It
normally works from a file, but you can work it from a
variable. I’ve not studied all of it yet, but from the
little I read, I worked out how to do a floating point
division. This page was very helpful: Awk Primer —
print and printf()

Anyway, the line I had to use was this (I’ll explain
what it all means in a minute)

temp3=$(awk -v m=$temp1 ‘BEGIN { printf(“%-
.3f”, m/1000) }’)
temp1=${temp3:0:5}

The awk command returns a string in this case, so
by placing the command inside brackets, preceded
by a dollar sign, we can allocate the result to a
string. The “-v m=$temp1” is important, because it
defines a variable to be used by the command.
Otherwise, it will require a file. ‘BEGIN {….} ‘ is part
of the syntax for awk, I don’t pretend to understand
it yet. printf() is a formatted string and the page I
referred to above was very helpful in understanding
it. The first, quoted, string inside the brackets,
defines the format, in this case, %-.3f means left
justified, floating point, to 3 decimal places. The
following line just reduced the result to 4 significant
figures (5 characters including the decimal point)

OK, with this knowledge, I can build a nice and short
script, tailored to my own computer. I did this, then
one day it returned an error! Why? Well due to the
linux system’s hardware detection, it allocated
hwmon0 and hwmon1 the other way around! So I
added a test for this, and here is the final script

(Ed. Note: Each group of text is one line, separated
for clarity).

#!/bin/sh

if [ -e /sys/class/hwmon/hwmon1/temp1_input
] ;

then

temp1=`cat
/sys/class/hwmon/hwmon1/temp1_input`

power1=`cat
/sys/class/hwmon/hwmon0/power1_input`

else

temp1=`cat
/sys/class/hwmon/hwmon0/temp1_input`

power1=`cat
/sys/class/hwmon/hwmon1/power1_input`

fi

#4 more lines later added here, see below

temp3=$(awk -v m=$temp1 ‘BEGIN { printf(“%-
.3f”, m/1000) }’)

temp1=${temp3:0:5}”°C”

power2=$(awk -v m=$power1 ‘BEGIN {
printf(“%-.3f”, m/1000000 )}’)

power1=${power2:0:5}”W”

echo “<img>/usr/share/icons/temperature-
s.png</img

echo “<txt>$temp1</txt>”

echo “<tool>Heat Transfer: $power1</tool>”

echo “<click>psensor</click>”

This brought about a further problem. The

XFCE4: Using the General Monitor (Genmon)
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temperature returned by my Athlon FX4100 CPU is
unrealistically low. This is because the figure it
returns is designed to show how much stress the
CPU is under, and doesn’t become accurate until the
processor starts getting hot. Telling me that the
processor is running at 8°C on a hot summer’s day,
is clearly wrong. I picked a number off the top of my
head, and decided that the figure becomes accurate
at 60°C, and that I would add a third of the difference
between the recorded temperature and the 60. For
most processors this would not be a problem, but of
course, when you write your own script, you can do
what you like!

So I added these few lines where indicated in the
script.

tempdiff1=$((60000-$temp1))

discrim=$(($tempdiff1>0))

tempdiff2=$(($tempdiff1*$discrim/3))

temp2=$(($temp1+$tempdiff2))

These lines measure the difference if the figure
returned is under 60, and if it is, divide it by 3 and
add it to the temperature provided by the sensors.
Note you’re left with “temp2” here so you would have
to make a change the following line, starting
“temp3=”, change “m=$temp1” to “m=$temp2”.

Another thing you can do, if you prefer Fahrenheit,
is, in the line starting “temp3=”, change m/1000 to
32+9*m/5000. And in the following line, change “°C”
to “°F”.

You need to save the file, (I’ve called mine “correct-
temp”) in the /usr/local/bin folder, and make it
executable, but before you attach it to a GenMon,

you need to check that it works. If you run it in a
terminal, you should see four lines of output, as
shown further up this article. You will also need to
have an icon called temperature-s.png in your
/usr/bin/icons folder. There is one here for you:

https://dl.dropboxusercontent.com/u/81695069/temp
erature-s.png

To add the script to GenMon, first you have to install
xfce4-genmon-plugin from Synaptic, then add it to a
panel. Right click on it, then select Properties, you
just need to put the name of the script into the box
labelled “Command” and set the time you want it to
repeat, in seconds.

I hope that you can find a way of using genmon to
expand the possibilities of XFCE4 on your desktop.

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!

Support PCLinuxOS! Get Your Official

PCLinuxOS
Merchandise Today!
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by horusfalcon

DISCLAIMER: Kanboard is not a part of the official PCLinuxOS software
repository. As such, you should not expect official support for it via the
PCLinuxOS forums. If I see someone needing help, I’ll do my best, but there
are no guarantees expressed or implied with regard to its use.

PART I: WHAT IS KANBAN?

So what is Kanban, anyway? The word is Japanese for “billboard”. The history of
Kanban started with Toyota Motor Corporation. From there it has become an
accepted part of lean manufacturing processes in businesses the world over.

Briefly, Kanban is a simple inventory control/project management tool that uses
objects (task or signal cards) to track parts status and critical processes of a
project.

Originally, Kanban used a tracking board (a corkboard, typically) on which signal
cards were moved from one status lane to the next to indicate movement through
the workflow. These, in turn, triggered the generation of Kanban cards that tell
each supplier in the workflow when to have parts or subassemblies ready for their
downstream customers.

A typical Kanban board is shown below with a few simple tasks:

(Figure 1: image courtesy of https://kanboard.net/)

A much more technical (and more accurate) description of Kanban is given at
https://en.wikipedia.org/wiki/Kanban for any who are interested.

As the information age matured, physical cards were replaced with software
triggers and email notifications, but the principles remain the same. Electronic
kanban boards are also good graphical representations of project status.

My tribulations in getting Kanboard to run are in this thread: Kanboard on
PCLinuxOS. It’s not necessary to read it unless you want to subject yourself to
every step of my journey to install Kanboard on my PCLinuxOS-powered laptop.
Fortunately, I have learned enough along the way that your journey to get
Kanboard working should be much easier going than mine was.

So … what do I use Kanban for? I’ve adopted and adapted it as a focus tool to
help me control the flow of writing projects on which I’m presently working. This
has different working principles than more orthodox Kanban does as I’m the sole
supplier and customer, but it helps me stay focused on what’s next to be done,
and (especially) where interdependencies exist in my work. It has helped me
meet deadlines, and that’s the most important thing. When I first learned there
was an application for creating and maintaining an electronic Kanban board in
Linux, I knew I had to get it working.

If your business or even your personal projects could benefit from the type of
tracking Kanban provides, the solution is at hand. Meet Kanboard.

PART II: DOWNLOADING KANBOARD:

Kanboard is a web-based Kanban board application written in PHP. It can be
found at https://kanboard.net/downloads.

Once on the Kanboard website, look around. There is a comprehensive set of
documentation, plugins (which I’ve not tried yet) to enhance its functionality, news
about Kanboard’s development, and other great resources for Kanboard users.

Download the latest stable version of Kanboard from the website, and save it
somewhere you’ll be able to find it for later use.

Using Kanban On PCLinuxOS: Installing Kanboard
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PART III: MEETING THE SYSTEM REQUIREMENTS:

Hardware-wise, any system that can run PCLinuxOS and has reasonably good
display resolution should be able to run Kanboard. There are, however, some
software prerequisites that must be installed prior to installing the Kanboard
software. For PCLinuxOS, these have been made very simple.

The system requirements for Kanboard are listed at
https://kanboard.net/documentation/requirements.

The Kanboard website lists several non-PCLinuxOS distributions of Linux as
being compatible. I can personally vouch for the compatibility of PCLinuxOS as
well.

NOTE: Before adding any packages from the repository or installing software
from an archive, it is always a good idea to ensure your PCLinuxOS system is
fully updated. Instruction for how this is done may be found at
http://pclinuxoshelp.com/index.php/Update_Your_PCLinuxOS

PCLinuxOS has made meeting all the software requirements for Kanboard truly
easy. Open Synaptic Package Manager, give the root password when prompted,
and install task-lamp. This will install and configure a web server (Apache), a
database (MySQL), and PHP5 all in the same operation. It will also set up the
locations to which Kanboard should be unpacked.

NOTE: It is best to install task-lamp on a freshly installed PCLinuxOS system, but
so long as you have not previously re-configured PHP or MySQL, installing task-
lamp will get you where you need to be in one step.

PART IV: INSTALLING KANBOARD:

Here’s where we do something with that archive file downloaded in Part II. First,
as root, copy the archive file to /var/www/html/. You will need to be root to be able
to write to that folder. To do the copying using a shell session, do:

[username@localhost ~]$ su
Password: {key in the root password here and press Enter.}
[root@localhost username]# cp /path-to/kanboard-1.0.32.zip
/var/www/html/kanboard-1.0.32.zip

NOTE: the placeholder “username” above will be replaced with your user name.
The placeholder “/path-to/” will be replaced by the actual path where the archive
file is stored. The actual file name used should be that of the latest stable version
of Kanboard (which, as of this writing, is 1.0.32.)

Once the archive is copied to /var/www/html/, give the following shell commands
as root to unpack the archive:

[root@localhost username]# cd /var/www/html
[root@localhost html]# tar -xzvf kanboard-1.0.32.zip

This should unpack the archive to a new folder within /var/www/html, at
/var/www/html/kanboard.

At this point Kanboard is installed. To get it to run properly we must first do a little
post-install configuration.

PART V: CONFIGURING PERMISSIONS FOR KANBOARD

To be able to edit projects in Kanboard, the user must have write permissions
on the folder /var/www/html/kanboard/data.

The best way to accomplish this is, as root, to add the user to the group apache,
then assign ownership of the folder /var/www/html/kanboard/data to the apache
group. Finally, assign write permission to the folder’s owner and group.

The group and user operations can be done from the PCLinuxOS Control Center
very easily without recourse to a shell. Click the icon on the panel for Configure
your Computer to start PCLinuxOS Control Center, enter the administrative (root)
password when prompted, and then select System from the sidebar at left as
shown.

(Figure 2: PCLinuxOS Control Center System Menu)

Using Kanban On PCLinuxOS: Installing Kanboard
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From the System Menu, click on Manage users on system. This brings up:

(Figure 3: PCLinuxOS Control Center Users and Groups Dialog)

NOTE: my user details are obscured above for reasons of privacy and security.

In the Users and groups dialog, click to highlight your username, then click
Actions and select Edit from the drop-down menu. This will open the user’s profile
dialog (top, next column):

(Figure 4: Edit Groups/Users Dialog)

From here, click on Groups at the top right corner in the menu bar. This will open
the group list for the selected user.

(Figure 5: Edit Groups/Users, showing Groups Tab)

Using Kanban On PCLinuxOS: Installing Kanboard
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From here, click to select the group apache as shown above. The check mark in
the picture above shows it is already selected for my user, and if this is already
checked for you, no further action is needed as you are already a member of the
group. If the box has no check, click it to put one there, then click Ok. This
completes the user edits needed, for this user. Do the same for any other users
who may need access to Kanboard, and close the Users and Groups window and
the PCLinuxOS Control Center windows when done.

The assigning of permissions to the folder /var/www/html/kanboard/data can be
accomplished easily enough as root by editing the properties of the folder from
within any file manager (Dolphin, Caja, PCManFM, Nautilus, and others should
be able to do this easily). I will show PCManFM in use in my examples to follow,
since I am using LXDE for my desktop environment.

Root PCManFM is available from the PCLinuxOS start menu under File Tools
from LXDE. Click to start it, and a dialog box will open requesting the
administrative (root) password. After this is entered correctly, the file manager
window will open, showing root’s home folder.

(Figure 6: Root PCManFM)

From here, click on the blue “up arrow” shown under Bookmarks in the picture
above. Similar controls exist for most any file manager you might be using. The
folder you wish to navigate to is /var/www/html/kanboard/, such that the folder
/var/www/html/kanboard/data is displayed as an icon:

(Figure 7: PCManFM showing the data folder highlighted)

Right-click on the data folder icon and select Properties from the context menu.
This will bring up the folder properties dialog (next page):

Linux Docs
Linux Man Pages

Using Kanban On PCLinuxOS: Installing Kanboard
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(Figure 8: PCManFM showing Properties Dialog for the data folder)

Click on the Permission tab of this dialog, and it will display:

(Figure 9: Setting folder permissions)

If the values in the dialog box do not appear as shown, click, type and/or select to
change them as shown. This will assign the folder to the proper owner and group
(in the top section), and will grant the owner and selected group (and hence any
users in that group) the proper permissions. Click OK after all selections are
made, the dialog will close and all changes to the folder’s permissions will be
saved. Close Root PCManFM at this time (unless other actions requiring root
access remain to be done).

PART VI: STARTING KANBOARD

The hard work is done. To start Kanboard, open a web browser (I use Pale Moon,
but Firefox, Chrome, and others should also work fine) and point your browser to:

http://localhost/kanboard

This will open a login dialog. The first time you log in to Kanboard, you should log
in as the user admin with the default password admin, and, as your first official
act, change this default to something more secure. Click the purple circle icon in
the upper right to open the admin user’s settings menu

(Figure 10: Kanban Admin’s Dashboard with Settings Menu open)
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Click on My profile to open admin’s profile. When the dashboard loads, look
under Actions in the sidebar at left:

(Figure 11: Admin’s Profile showing Actions Menu at left)

Click Change password and get to it. Please write your new password down in a
notebook or otherwise ensure you can remember it. If you lose or forget it, you
will be unable to login as admin.

While you’re in the dashboard, look up at the top left. A set of links there allow for
group and user management. Click “New local user” to add a new user (like your
normal local user) to Kanboard as a user.

(Figure 12: Admin’s Dashboard showing User/Group Management Links)

The shot below (next page) shows the dialog for adding a new local user. To be
clear, the term local user means a Linux user local to the machine. All that is
really required to be entered here is the username, password, and password
confirmation. All the details at right can be added later on if other members need
to be added to this user’s projects.

If, for example, we wished to add the local user johnboy to kanboard, we would
enter johnboy for the Username, and a temporary password (e.g., temp1234) that
the user could change on their first time logging in. Click save, and the local user
is added. Admin (or johnboy) could edit johnboy’s details later via the dashboard.
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PART VII: CONCLUSIONS

That’s as far as I will take you for now. Once you create a local user for yourself,
knock around and play with Kanboard. If you want to do it the easy way, the
documentation is accessible from the dashboard (see Figure 10, above), and
more information for Kanboard can be found at https://kanboard.net/features and
elsewhere on the Kanboard website.

Such features as plugins, remote users and collaborative features others may
find useful are beyond my present use case, so I leave them for you all to explore
as you may need. Kanboard is really simple to use for something so packed with
features, and should serve well for any Kanban needs most folks will have. Enjoy!
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D
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Possible score 244, average score 170.
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anniversary

birthday

celebration

confetti

entertain

event

festive

friends

gathering

guests

happiness

happy

invitation

jubilee

milestone

party favors

thank you note

wingding

wrapping paper

years

O P E Z G X N V A O T Z O K C X Y X B Q T J A B H W G G N T
Q K E X Y I K P F Q T C Z U J V P L Q H S U P Q S M N V I B
O Q L I T A N D K P D X Y G Y Y P Y C K J E G O J W O I Q B
B Z I Z I T N C F C R Z C N Y R A S R E V I N N A R I J A J
T C B N I D B D J U Y C D E S N H Q I I L A O A Y P T P D R
I Q U P K V V Z N K R W T Z G H G D T Z W E N Y S R A E Y P
M G J X H N L G I N W Y O N U Y S S C M U L B V K K T J K X
U R U C P W Q P L X R A G N I R E H T A G D K R C Q I G W E
A N E U A N A T O D A T M P N F O F S L I K R F A Q V A T C
U M X T E E H H J X P V Y L A V I I Z G F W S B V T N I T I
T F P O U M D Z L X P W G T E R E U M W C F E P E P I E N P
P J Z X N D E K O T I O D D R S U F W Y R C T K S X N O S M
A P Q M Z U B H H E N P F I D Q W I V Z A E C G E T V E N S
Q Q I Y X B N H J U G Q E X H C A T Y W K D W S E M C I C S
D C Q Y Y R F A K I P H S P T U Y D Z E Y S H R J C J J D U
E Q H D S H T F D J A H L B E J H C O N F E T T I D G N E Z
K Z Y G Y O V M E Q P H A Z H L T P I U Q A M U R H E T O E
O T G W G D D W F U E Y E Z T U Z Z Z L I F R O X I S L J A
G P W T J S I A X M R Y M I L E S T O N E P Q I R N B Q G E
D G S S E N I P P A H X U Z G T L K Q Q T W A F W Z V C Y T
X I U T G M A Z Y E T N P H Q S Z T X P F R N N J F A K B O
F M J D X B W T P N L L P J B O Y T T P A R U G S W X G H N
T L I P T G F R E B O K M W C Y A C V K V O M R P P B I G U
E N F N R U V V O P A R T Y F A V O R S G A H K S D G H R O
G H U Q K H E K F L U X O W V A D K G T A R V C S C B U E Y
H N J Q N M H Q E Q F V B S W A N S Y S U F V M G E G M M K
I F O F U Z N P D R B K D Q F H R A N E E H Y E A Z J C F N
Y Z C Z U M Q Z S H A H K I O K G Z Q U Y P V W Q G E F A A
T O Q Q F Q H M R D T E P L O B Y G Z G R T D F V Q I O Q H
L N V V U C D T P V Y S H R W Y K N F O B M N W F T L U Q T
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1. You always write one to
express appreciation

2. Glad or pleased about
something

3. Everyone in attendance
4. The length of time the

PCLinuxOS Magazine has
been published

5. Celebration of one’s birth
6. A significant event in

someone’s life
7. A wonderful feeling
8. The best people to have at

a celebration
9. Give attention or consideration

to, or perform for
10. Cheerful and jovially

celebratory
11. A special anniversary of an

event
12. A date or happening worth

remembering
13. Tiny bits of colorful paper

thrown during a celebration
14. Covering the gifts
15. The date on which an event

took place in a previous year
16. Another name for party
17. Doing something special for

an important event
18. “Please come to my party”
19. Coming together to celebrate
20. Gifts, noisemakers and prizes
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Posted by onkelho, on August 3, 2016, running Xfce. Posted by OnlyHuman, on August 1, 2016, running e21.

Posted by parnote, on August 11, 2016, running Xfce. Posted by tbschommer, on August 13, 2016, running KDE.
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